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1 License Agreement

Please note that by using RAILMODELLER you are
accepting our terms and conditions as set out below.

THIS SOFTWARE AND ALL RELATED DOCUMENTATION IS PROVIDED
TO YOU ”AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMI-
TATION, ANY FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT WILL THE AUTHORS OF RAILMODELLER BE LIABLE TO
YOU OR ANYONE ELSE FOR ANY DIRECT, SPECIAL, INCIDENTAL, IN-
DIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAM-
AGES WHATSOEVER, ARISING OUT OF OR IN CONNECTION WITH
THE POSSESSION, USE OR INABILITY TO USE OF THIS SOFTWARE,
EVEN IF THE AUTHORS HAVE BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES.

THIS SOFTWARE IS OWNED BY THE AUTHORS OF RAILMODELLER.

PAYING THE LICENSE FEE ALLOWS YOU TO USE ONE COPY OF THE
SOFTWARE ON A SINGLE COMPUTER. YOU MAY NOT NETWORK THE
SOFTWARE OR YOUR PERSONALIZED REGISTRATION-KEY OR MAKE
IT AVAILABLE FOR USE ON MORE THAN ONE COMPUTER AT THE
SAME TIME.

RESELL OF THE LICENSE KEY IS STRICTLY PROHIBITED.

BY VIOLATING ANY PART OF THE AGREEMENT YOUR RIGHT TO USE
THE SOFTWARE TERMINATES AUTOMATICALLY. IN THIS CASE THE
AUTHORS OF THIS PROGRAM RESERVE THE RIGHT TO TAKE ANY
FURTHER ACTIONS.

YOU MAY NOT RENT OR LEASE THE SOFTWARE, NOR MAY YOU
MODIFY, TRANSLATE, REVERSE ENGINEER, DECOMPILE OR DISAS-
SEMBLE THE SOFTWARE. VIOLATING ANY PART OF THIS AGREE-
MENT AUTOMATICALLY TERMINATES YOUR RIGHT TO USE THIS SOFT-
WARE. IN THIS CASE YOU MUST DESTROY ALL COPIES OF THE SOFT-
WARE IN YOUR POSSESSION.

IF YOU DO NOT AGREE TO THESE TERMS, PROMPTLY DELETE AND
DESTROY ALL COPIES OF THE SOFTWARE AND RELATED DOCU-
MENTATION IN YOUR POSSESSION.



2 Installing and Updating RAILMODELLER

2.1 Installing the Application

Installing RAILMODELLER is very simple:

Copy the RAILMODELLER folder to the desired location – for example
the Mac OS X Applications folder – on your hard drive.

Congratulations, you’re done!

2.2 Entering the License Key

If you have purchased a RAILMODELLER license make sure your license key is
recognized by the application.

Choose the “General > Registration” panel in the “Preferences” to check if your
registration information is displayed correctly.



If the application is running in the demo mode you can use this panel to enter your
personal license key. You will then be asked to chose the location of your rm.key .

RAILMODELLER will automatically install the license key in the appropriate di-
rectory1 where it can be accessed automatically when the application is updated so
there’s no need to reinstall the license after an upgrade.

2.3 Location of Files and Folders

RAILMODELLER requires the Railsets folder to remain in the same directory
where the RAILMODELLER and RAILSET EDITOR applications are located.

Your worksheets and the stock file can be stored at arbitrary locations.

1 License files are stored in the user’s /Library/Application Support/RailModeller/Software License
directory.
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3 RailModeller Manual

3.1 Introduction

RAILMODELLER was designed to make the creation of layouts for model railroads
and slot car systems a fun and easy activity.
The user interface was kept as intuitive as possible, so chances are that users won’t
have to refer to the manual most of the time.

This chapter provides a quick overview of what to find where in this manual.

Figure 3.1: Overview of the RAILMODELLER user interface.

The next chapter gives some general tips and tricks for setting up RAILMODELLER

and working with the user interface (⇒ 3.2) . This chapter is highly recommended
for novice as well as experienced RAILMODELLER users.

Chapters 3.3 and 3.4 provide a detailed description of the RAILMODELLER user
interface.

The tools chapter (⇒ 3.5) provides an overview of the various tools you will use
when working with a layout.



The following chapters starting with the Railsets chapter (⇒ 3.6) describe some
general RAILMODELLER concepts as well as specific tasks and editors involved in
mastering these tasks.

3.2 First Steps

When you start working with RAILMODELLER it’s a good idea to adjust the user
interface to fit your specific requirements and taste. There are many options that
allow changing the layout of the program windows and customization of other as-
pects of the user interface.

Whenever a panel is mentioned it refers to a panel in the “Preferences” dialog.
The appropriate panel can always be selected in the category list on the left side of
the dialog.

3.2.1 Adjusting Language and Units of Measure

When started for the first time RAILMODELLER attempts to detect your current
system language. However, if you need to manually change your locale you can do
so in the “Language & Units” panel.

If you prefer working with imperial units you might want to change the units used
throughout RAILMODELLER in the same panel to any other supported measure-
ment unit, e.g. to Inch.

3.2.2 Choosing Your Preferred Railset

Most of the time you will be working with the same railset. Let’s assume you have
3 boxes with LGB tracks in your cellar, so you will most likely be using the LGB
railset 95% of the time. Choose the appropriate library in the “Railset Palette” (⇒
3.3.2) , then open the “User Interface > Railset Palette” panel and use “Change
to Railset” to make it the default railset.

RAILMODELLER will now automatically load the specified railset to the “Railset
Palette” when the application is launched.

3.2.3 Adjusting the Railset Palette

The “User Interface > Railset Palette” provides various options to customize the
“Railset Palette” :

· The “Railset Palette” can be displayed either in a horizontal or vertical fash-
ion (⇒ 3.3.2)

· Tooltips can automatically show information about the element currently un-
der the mouse cursor

· Obsolete elements can be indicated with markers in the “Railset Palette”

· The number of elements remaining in the stock is optionally shown for each
element of the library currently display
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3.2.4 Customizing the User Interface

The various panels in the User Interface section of the “Preferences” dialog allow
the further customization of various aspects of the user interface. It might be a good
idea to check all panels to detect useful options.

The “Window” menu is used to show or hide any RAILMODELLER window. On
Macs with a low screen resolution it might be a good idea to hide the Information
and Color Palette windows and switch the “Railset Palette” to the horizontal mode,
thus enabling the Worksheet Window to use the full screen width.

3.2.5 Setting up the Stock

When starting to work with RAILMODELLER you might also want to set up the
stock. This allows you to continually monitor how much tracks are left in your 3
boxes of LGB tracks when designing a new layout, either in the partlist (⇒ 3.12)
in the “Railset Palette” (⇒ 3.3.2) .

3.2.6 Tip #1: Tooltips

RAILMODELLER provides online help for various user interface elements via tooltips.
The tooltips are displayed when resting the mouse cursor on any element of the user
interface and reveal

· the meaning of a particular label (e.g. in the Information Window)

· the function performed by a particular button

· the meaning of an option in the “Preferences” dialog

3.2.7 Tip #2: Contextual Menus

RAILMODELLER uses contextual menus to provide shortcuts for actions that make
sense in the particular context, e.g.

· to edit an element or show information about an element

· to connect a segment to an element

· to hide a palette window
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It is always a good idea to check throughout the user interface what contextual
menu functionality is available for a particular element.

If you are not familiar with contextual menus it might be a good idea to read the ”Using contextual
menus” section in Mac Help “Finder > Help > Mac Help” .
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3.3 The Windows

Picture (⇒ 3.1) shows the user interface of RAILMODELLER consisting of the
five windows, which are permanently visible:

1. The Worksheet Window

2. The Railset Palette

3. The Toolbar

4. The Info Window

5. The Color Palette

3.3.1 The Worksheet Window

The Worksheet window contains the layout currently under construction.

The title of this worksheet is displayed in the title-bar of the window. The small
icon in the title-bar indicates whether the document has been changed since saving
it to disk. A dimmed icon indicates that the document has been modified. The
title-bar can also be used to quickly navigate to the folder where the worksheet is
stored in by holding

�� ��CMD and clicking in the title-bar.

3.3.2 The Railset Palette

The “Railset Palette” provides quick access to all libraries that are stored in the
“Railsets” folder.

The currently visible set of libraries is always filtered by

1. Scale (H0, IIm, Z, . . . ), and

2. Type (Tracks, Accessories, Slot Car, . . . )

If you can’t find the particular library you’re looking for please make sure these
filters are set correctly1.

The “Railset Palette” always displays the elements of one railset – the current
railset – at a time. Each element of the current railset is represented by a button
in the “Railset Palette” . Within this button the following information is displayed
for each element:

· The product-number at the bottom.
If “Display Show Railset-Prefix” is enabled, the product numbers displayed
also include the railset prefix.

· A graphical representation of the element.
If the mini-graphic doesn’t fit into the button a short description of the ele-
ment is displayed instead (See element “Mä-5147” in figure 3.2).

1 Please note that most of the slot car libraries have “Custom” scale.
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· Optionally, the (un-)availability of the element is indicated with a cross in
the upper, left corner. This option can be turned on in the preferences.
For more information about element availability flags please refer too (⇒
3.7) .

· Optionally, the number of elements remaining in the stock is displayed in the
upper, right corner. This option can be turned on in the preferences.
A small icon indicates if no more stock elements remain for the current work-
sheet (all elements from stock used).

Figure 3.2: The “Railset Palette” showing the Maerklin H0 M railset.

There is always one element – the current element – selected in the current railset
(Mä-5200 in figure 3.2). The current element is changed by selecting another el-
ement with the mouse or using

�� ��TAB to select the next and
�� ��SHIFT +

�� ��TAB to
select the previous element in the “Railset Palette” .

To insert an element from the current railset into the layout it can either be dragged
from the buttons to the layout or the current element can optionally be inserted into
the layout by clicking into the Worksheet window at the desired location (see (⇒
3.9.1) for details).

The name of the railset currently loaded is displayed in the popup-menu (“Maerklin
H0 M” in figure 3.2). The scale used in the “Railset Palette” is calculated automat-
ically by RAILMODELLER, the scale currently used is indicated in the popup-menu
on the upper, right border of the palette.

More information about the current railset is available in the “Railset Info” dialog
(“Element > Railset Info” ).

Descriptions of railset elements are available in the area on the bottom of the
“Railset Palette” when the mouse-cursor is placed over a particular railset ele-
ment. The description is also displayed as a tooltip when

�� ��OPTION is pressed,
alternatively the description can be turned on with the “Railset Palette” Tooltips
option in the preferences to show up automatically when the mouse cursor hovers
the palette buttons. The Element Info dialog for an element in the palette can be in-
voked either via the contextual menu or by clicking on a “Railset Palette” element
while holding

�� ��CMD .

Please refer to section (⇒ 3.9) for further information on working with elements.

The “Railset Palette” can be displayed either vertically with all elements of a
railset displayed in two columns or horizontally with all railset elements displayed
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in a single row. The orientation is chosen in the preferences in the “Railset Palette”
tab or directly from the Railset Palette popup menu in the upper, right border.

The sorting mode of elements in the “Railset Palette” can also be controlled via the
Railset Palette popup menu. The sorting can either be taken from the library as it
was defined by the railset creator or it can be re-sorted dynamically, which means
the sorting mode affects only the display of the railset elements in the “Railset
Palette” but it does not change the railset itself.

3.3.3 The Toolbar

The Toolbar is always located on the top of the screen right beneath the menu-bar.
Most operations used very frequently when working with RAILMODELLER like
loading, saving or printing files, edit-operations and switching between the various
tools can be performed using the toolbar.

The bottom area of the toolbar contains the status-bar. RAILMODELLER uses this
area to issue messages, e.g. the reason why a particular operation failed or instruc-
tions on the current operation. Minor errors – e.g. when a flextrack could not be
used to connect two elements – are only reported in the status-bar, whereas major
errors – e.g. the export of a picture failed – are displaying in a separate error-dialog.

In the “User Interface > Toolbar” panel of the Preferences the appearance of the
Toolbar can be configured to use small or large icons. It is also possible to select
which functional groups should be displayed in the Toolbar. The configuration
can also be done directly in the Toolbar using the contextual menu. The following
provides an overview of all Toolbar buttons sorted by groups.

The File Group

Load Worksheet : Open an existing worksheet (layout).

Save Worksheet : Save modifications to the current worksheet.

New Worksheet : Opens a new worksheet.

Close Worksheet : Closes the document currently opened.

Print Worksheet : Prints the current worksheet.

Partlist : Opens the partlist (⇒ 3.12)

Stock : Opens the stock (⇒ 3.15)

The View Group

Zoom Out : Decrease the zoom level and show a larger part of the current layout.
For a magnification of 100% a pixel on the screen measures 1 millimetre.

Zoom In : Increase the zoom level to show more details of the current layout.

Zoom In : Increase the zoom level to show more details of the current layout.

Zoom To Fit : Change the current zoom level to make the complete worksheet vis-
ible.
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View in 3D : Switch to the three-dimensional view of the current worksheet (⇒
3.13) .

The Edit Group

Undo : Undo the last action.

Redo : Redo an action previously undone.

Cut Element : Remove the selected element from the worksheet and place it in the
clipboard.

Copy Element : Place the selected element in the clipboard.

Paste Element : Insert an element formerly copied to the clipboard.

Delete Selection : Delete elements in the current selection.

The Tools Group

Create/Select : Switch to the Create/Select-Tool (⇒ 3.5.1) .

Select : Switch to the Selection-Tool (⇒ 3.5.2) .

Measure : Switch to the Measurement-Tool (⇒ 3.5.3) .

Move : Switch to the Move-Tool (⇒ 3.5.4) .

Info : Switch to the Info-Tool (⇒ 3.5.5) .

Sample : Switch to the Pipette-Tool (⇒ 3.5.6) .

Colorize : Switch to the Bucket Fill-Tool (⇒ 3.5.7) .

Text : Switch to the Text-Tool (⇒ 3.5.8) .

Rectangle : Switch to the Rectangle-Tool (⇒ 3.5.9) .

Polygon : Switch to the Polygon-Tool (⇒ 3.5.11) .

Circle : Switch to the Circle-Tool (⇒ 3.5.10) .

Line : Switch to the Line-Tool (⇒ 3.5.12) .

The Element Group

Group Selection : Create a new group with the current selection.

Ungroup Selection : Dissolve the selected group.

Move Selection : Open the Move Dialog for the currently selected element.

Rotate Selection : Open the Rotate Dialog for the currently selected element.

Joint Rotate Element : Rotate the currently selected element around its connected
joint (⇒ 3.9.1) .

Bring to Front : Change the order of the currently selected element to be displayed
on top of all other elements.
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Send to Back : Modify the currently selected element to make it draw behind all
other elements.

Edit Element : Open the specific editor for the currently selected element.

The Attributes Group

Color : Colorize the selection or choose a default-color.

Linewidth : Apply linewidth setting to the selection or choose a linewidth.

3.3.4 The Information Window

The Information Window contains general information about the element or the
group of elements currently selected.

The available data comprises the position and dimensions of the element as well as
the current angle and the overall length of all tracks. For a single selected element
the product number and description can be displayed optionally in the Information
Window by enlarging the window via the disclosure triangle at the bottom of the
window. The position of the window is stored in the preferences when RAILMOD-
ELLER quits and restored when the application restarts.

3.3.5 The Color Palette

The Color Palette provides quick access to the current color, the default color,
which is used to colorize elements inserted in the worksheet. The color can ei-
ther be chosen from a fixed number of pre-defined colors or freely selected via the
Mac OS Color Picker palette. The large pane at the bottom of the Color Palette
shows the default color currently chosen.

Click on any pre-defined color to choose it as the new default color or click on a
pre-defined color while pressing

�� ��OPTION to choose it as the new default color and
to colorize the current selection with this color.

Click on the default color pane choose a new default color by invoking the Mac OS
Color Picker palette or click on the pane while pressing

�� ��OPTION to choose a new
default color and colorize the selection with the newly chosen color.

3.3.6 The Layer Palette

The Layer Palette allows creating, renaming, deleting layers. You can show or hide,
lock or unlock a layer and change the order of layers in the Layer Palette.

The highlighted element in the Layer Palette is the active layer. Click a layer in the
Layer Palette to set it as active layer. Double-click to rename a layer.

Details about working with layers can be found in (⇒ 3.11) .

3.4 The Menus

This section provides an overview of all menus in RAILMODELLER and a short
description for each menu command.
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The File Menu

New Worksheet : Create a new, empty worksheet.

Open Worksheet : Open an existing worksheet.

Open Recent : Shortcuts to open the worksheets recently loaded.

Close : Close the worksheet currently opened.

Save, Save As : Save the worksheet to disk.

Revert : Close the worksheet currently opened without saving the changes and re-
vert to the last saved version of the worksheet.

Worksheet Info : Opens the “Worksheet Info” dialog providing detailed informa-
tion and statistics about the opened worksheet.

Export as Image : Exports the worksheet as a PNG, JPEG, PSD, TIFF or PICT
image.

Export to TrainPlayer : Exports the layout data and a PNG image of the layout to
be imported into the TrainPlayer application.

Export to SLIF : Writes the layout as Simple Layout Interchange Format (⇒ C)
file for importing the layout into third party applications.

Stock : Opens the “Stock” dialog.

Page Setup : Opens the printer settings dialog.

Print : Prints the current worksheet.

The Edit Menu

Undo, Redo : Undo the last action or redo an undone action.

Cut : Remove the currently selected element from the worksheet and place it in the
clipboard.

Copy : Copy the selected element to the clipboard.

Paste : Insert the clipboard element in the worksheet at the current mouse position.

Paste Original Position : Insert the clipboard element in the worksheet at the posi-
tion of the original element.

Clear : Delete all elements currently selected.

Select : The following commands are available in the Select submenu:

· Select Connected Elements
All elements connected to the selected element are selected.
(Enabled only for a single selected element)

· Similar Elements
For elements from railsets select the same product-number.
For generic elements (circles, text, . . . ) select same type.
(Enabled only for a single selected element)
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· Similar Colored
All elements of the same color are selected.
(Enabled only for a single selected element)

· Similar Manufacturer
All elements of the same manufacturer are selected.
(Enabled only for a single selected element)

· Similar Railset
All elements of the same railset are selected.
(Enabled only for a single selected element)

· Similar Modelscale
All elements of the same modelscale are selected.
(Enabled only for a single selected element)

· All Tracks
All tracks are selected.

· All Text Elements
All text elements are selected.

· All Elements in Active Layer
All elements in the active layer are selected.

· Inverse
All selected elements are unselected and all elements formerly unse-
lected become selected.

Select All : Select all elements in the worksheet.

Unselect All : Unselect all elements.

The Worksheet Menu

Zoom In : Increase the zoom level to show more details of the current layout.
At a magnification of 100% a pixel on the screen represents 1 millimetre.

Zoom Out : Decrease the zoom level and show a larger part of the current layout.

Zoom To : Open the “Zoom To” dialog to enter a zoom level.

Zoom To Fit Worksheet : Change the current zoom level to make the complete
worksheet visible.

Center on Current Selection : Centers the worksheet on the current selection with-
out changing the zoom level.

View In 3D : Switch to the three-dimensional view of the current worksheet (⇒
3.13) .

Show Partlist : Show the partlist for the current layout (⇒ 3.12) .

Export Partlist as Text : Export the current partlist as a plain text-file or to the Clip-
board (⇒ 3.12) .
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Cleanup Orphaned Tracks : Invokes the “Cleanup Orphaned Tracks” function (⇒
3.10.8) .

Worksheet Properties : Opens the “Worksheet Properties” dialog to adjust vari-
ous settings of the current worksheet such as the layout dimensions and ad-
ditional information.

The Element Menu

Edit Element : Opens the type-specific editor for editing the properties of rectan-
gle, circle, or text elements (⇒ 3.9.3) and flex tracks (⇒ 3.9.5) .

Move To : Opens the “Move Selection” dialog (⇒ 3.9.8) for the currently se-
lected element.

Rotate : Rotates the selected element by various fixed amounts or opens the “Ro-
tate Selection” dialog (⇒ 3.9.9) .

Rotate Connected Joint : Invokes the “Joint Rotate” function to rotate elements
connected with only one joint to another element (⇒ 3.9.1) .

Colorize Selection : Colorizes the current selection with the currently chosen de-
fault color.

Choose Element Color : Opens the MAC OS Color Picker dialog to colorize the
current selection and/or choose a new default color.

Duplicate Element : Insert a copy of the selected element into the worksheet.

Insert Generic Flextrack : Insert a generic flextrack element2 with the gauge and
modelscale of the active railset.

Select in Railset Palette : Makes the currently selected worksheet element the ac-
tive element in the Railset Palette.

Group : Create a new group with the current selection.

Ungroup : Dissolve the selected group.

Ungroup All : Dissolve all groups in the worksheet.

Bring Element to Front : Change the order of the currently selected element to be
displayed on top of all other elements.

Send Element to Back : Modify the currently selected element to make it draw be-
hind all other elements.

Element Info / Selection Info : Opens either the “Element Info” dialog for the se-
lected element or the “Selection Info” dialog for a selection of several ele-
ments.

Railset Info : Opens a dialog with detailed information about the active railset.

Load External Railset : At startup time RAILMODELLER automatically loads all
railsets from the “Railsets” folder. To load any additional railsets use this
function.

2 Generic Flextracks are created on-the-fly and don’t belong to any railset.
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Launch Railset Editor : Launches the RAILSET EDITOR, see (⇒ 4) .

The Arrange Menu

Connect with Sectional Track : Closes a gap with tracks from the current railset
(⇒ 3.10.4) .

Connect with Flextrack : Closes a gap with a flextrack (⇒ 3.10.5) .

Connect Segment To : Connects a segment of tracks to another track (⇒ 3.10.6) .

Grade a Section of Tracks : Grades the currently selected track section (⇒ 3.10.1)
.

Create Grade to Track : Creates a grade to the selected track (⇒ 3.10.1) .

Set Height for Tracks : Adjusts the leveled height for the selected and all con-
nected tracks (⇒ 3.10.1) .

Create Track Helix : Creates a helix of tracks (⇒ 3.10.3) .

The Layer Menu

New Layer : Creates a new, empty layer.

New Layer with Current Selection : Creates a new layer and assigns the current
selection to it.

Rename Layer : Opens a dialog to rename the active layer.

Delete Layer : Deletes the active layer and all elements assigned to the layer.

Lock/Unlock Layer : Locks or unlocks the active layer (⇒ 3.11) .

Hide/Show Layer : Hides or shows the active layer (⇒ 3.11) .

Show All Layers : Shows all layers currently hidden.

Assign Selection To Active Layer : Assigns all elements in the current selection to
the active layer.

The Display Menu

Show/Hide Element Names : The name of each element is drawn on top of the
particular element when the option is active.
Element Names are always drawn on top of all other elements.

Use Outline Style : Elements names can optionally be drawn with a white outline
to be better readable by switching on this option.

Show Names For Tracks Only : Turn this option on to display only names for track
elements but not for other elements like trees, houses or plain lines, rectan-
gles and circles.

Show Track Height : Enable this option to display the height of track elements next
to the joints of a track.
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Display Heights on Grades Only : This option will prevent the display of height
for leveled tracks.
Ignored if “Show Track Height” is turned off.

Offset Height Labels : Turn this option on to offset height labels for tracks to be
displayed next to tracks, not on top of tracks.
Ignored if “Show Track Height” is turned off.

Element Name Color : This option opens a Color Dialog to select the color to be
used for rendering element names.

Element Name Textsize : The size of the element names can be controlled using
one of the presets in this submenu.

Show Railset-Prefix : Display the abbreviated name of the railset each element
originates from as a prefix preceding the element-names.

Element Prefix Style : The current style used for the Railset-Prefix display.

Track Drawing Style : Opens a dialog to control the track style for the current
worksheet (⇒ 3.9.7)

Show Height Profile : This option enables or disables the height profile view in the
lower part of the worksheet window.

Show/Hide Grid : The grid is displayed when this option is active.

Grid Spacing : Adjusts the spacing of the grid for the current worksheet.

Worksheet Colors : One of the 4 presets for worksheet background and grid colors
can be chosen in this submenu.

The Window Menu

Show/Hide Toolbar : Show or Hide the Toolbar.

Show/Hide Railset Palette : Show or Hide the Railset Palette.

Show/Hide Info Window : Show or Hide the Info window.

Show/Hide Color Palette : Show or Hide the Color Palette.

Show/Hide Layer Palette : Show or Hide the Layer Palette.

Show/Hide All Palettes : Show or Hide all palette windows.

Cleanup Windows : Reset all window-positions to their initial configuration iden-
tical to the positions when RAILMODELLER starts up.

Zoom Worksheet Window : Same effect as clicking the ⊕ button in the Worksheet
titlebar.

The Help Menu

RailModeller Manual : Opens the manual (Manual.pdf in the Documents folder).

Watch Tutorials : Invokes a web browser with the RAILMODELLER tutorial videos
available on the web.
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RailModeller Website : Invokes the RAILMODELLER homepage on the web.

RailModeller Community : Opens the community section on the RAILMODELLER

web site.

Send Email to MacRailSoft : Opens the email client to write an email to MacRail-
Soft.

Check for updates : Opens an internet connection to www.railmodeller.com
to check for the latest RAILMODELLER version available3

3 The update check connects to the webserver and looks for a file with the latest program version.
No personal information is sent to or stored on the server except for the program version currently
installed and the current Mac OS X version to identify the client as e.g. RailModeller/4.1
(Mac OS; 10.7.2) against the web server.
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3.5 The Tools

The tool currently selected affects the operation of the mouse-cursor or the options
currently available. This chapter explains the various modes.

3.5.1 Create/Select Shortcut:
�� ��V

This is the default mode when launching RAILMODELLER.

A mouseclick in an empty area of the worksheet inserts an element of the type
currently selected in the “Railset Palette” . Click and Dragging the mouse while
holding down the mouse-button selects all elements within the selection rectangle.
Hold down the

�� ��SHIFT key to select more elements whilst keeping the current
selection.

A mouse-click inside an existing element selects this element. All currently se-
lected elements are deselected. To add another element to the current selection
without deselecting the other elements hold down

�� ��SHIFT while selecting the el-
ement. To remove an element from the current selection – i.e. deselect a single
element – click in the selected element while holding down

�� ��SHIFT .
Triple click an element to select all tracks connected to the element.

To move selected elements in the worksheet drag any selected element to a new
position using the mouse. For groups of selected elements the whole group will
always move if any element from the group is moved. A single elements doesn’t
have to be selected before starting a drag operation.

3.5.2 Selection Shortcut:
�� ��S

The Selection mode is similar to the Create/Select mode with the exception that
elements cannot be created and clicks in empty areas of the worksheet deselect all
currently selected elements. The preferences option “User Interface > Various >
Select mode allows moving of elements” buttons whether elements can be moved
in this mode.

3.5.3 Measure Shortcut:
�� ��M

This tool provides a tape measure for taking measurements in the worksheet. When
the measurement starts near a joint of a worksheet-element the start-point of the
tape measure automatically snaps to the particular joint. The same holds for the
end-point of the tape measure. This allows the application to use the exact position
of the joint independent of the current zoom level to measure the exact distance
between joints at the highest possible resolution.

If not snapped to a joint the measurement will occur at drawing precision depending
on the current zoom level. For example, the precision at 100% zoom is 1mm, at
50% it’s 2mm, and only 10mm at 10% zoom level.

In case measurement starts at the joint of a particular worksheet element the name
of this element is printed to the toolbar’s message area.

If the end of the tape measure has snapped to a joint the tool indicates this by
displaying a thick ring around the snapped joint.
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A number of key combinations are provided to modify the behavior of the tape
measure.

Holding
�� ��CMD while measuring temporarily disables snapping to joints.

Holding
�� ��OPTION during measurements makes the tool display the measured dis-

tance on the left side of the tape. This can be useful if the tooltip showing the
measurement conceals some part of the layout you’re interested in.

Holding
�� ��SHIFT toggles the display mode to show the vertical and horizontal dis-

tances as distinct values as well as the height difference between the selected joints.

3.5.4 Move Shortcut:
�� ��H

When the Move mode is selected clicking in the worksheet and moving the mouse
while holding down the mouse-button moves the area currently displayed in the
Worksheet window.

The Move mode is selected temporarily from any other mode by holding
�� ��CMD

while clicking in the worksheet.

3.5.5 Info Shortcut:
�� ��I

When operating in the Info mode the productnumber and description of the element
under the mouse-cursor is displayed in a tooltip. A click in the element opens the
“Element Info” dialog.

3.5.6 Pipette Shortcut:
�� ��Y

This tool sets the global default-color to the color of an element placed in the work-
sheet. A mouse-click with the eyedropper in any element changes the default-color
to the elements color.

3.5.7 Bucket Fill Shortcut:
�� ��B

The Bucket Fill tool colorizes elements in the worksheet with a single mouse-click.
Elements are colorized with the current default-color as displayed in the “Color
Palette” (⇒ 3.3.5) and the “Color” button in the toolbar.
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3.5.8 Text Shortcut:
�� ��T

A mouse-click at an empty area of the worksheet inserts a new text-element with
the initial content set to “TEXT”.

Clicking an existing text-element starts the text-editor (⇒ 3.9.10) .

3.5.9 Rectangles Shortcut:
�� ��R

In this mode a mouse-click in the worksheet creates a new rectangle with the upper,
left corner located at the position where the mouse-click occurred. The size of
the rectangle can then be adjusted by moving the mouse-cursor while holding the
mouse-button down.

Holding
�� ��SHIFT while creating the rectangle produces a square.

Use
�� ��OPT while creating the rectangle to center the rectangle at the initial mouse

position.

The exact dimensions of the rectangle can also be adjusted in the “Rectangle Edi-
tor” (⇒ 3.9.11) .

3.5.10 Circles Shortcut:
�� ��C

Similar to the Rectangle tool a circle can be created in this mode by clicking in the
worksheet and dragging the mouse-cursor while holding down the mouse-button to
adjust the circle’s size.

Use
�� ��OPT while creating the circle to center the circle at the initial mouse position.

Alternatively the exact dimensions of the circle can be adjusted in the “Circle Edi-
tor” (⇒ 3.9.13) .

3.5.11 Polygons Shortcut:
�� ��P

New polygons are defined in Polygon mode. The points of the polygon are se-
quentially defined by mouse-clicks in the worksheet. As long as the mouse-button
is pressed the new points can be moved by moving the mouse. Holding down�� ��SHIFT while moving new points aligns them vertically or horizontally with the
previous point.

The definition of a polygon is finished by entering the last point with a double-click
or leaving the Polygon mode by switching to a different tool.

Existing Polygons can be edited with the Create/Select tool. Using the mouse-
cursor the polygon-point to be modified can be dragged to it’s desired new location.

More sopisticated editing functions like scaling or mirroring a polygon are avail-
able with the “Polygon Editor” (⇒ 3.9.12) .
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The contextual menu for polygon points provides options to insert new points or
delete a specific point.

3.5.12 Lines Shortcut:
�� ��L

Single lines or line-segments consisting of several connected lines can be defined in
this mode. In contrast to the Polygon tool the first and last point of a line-segment
will not be connected. Lines are also never filled with a solid color.

Otherwise this tool works similar to the Polygon tool.
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3.6 Railsets

Numerous libraries are included in the RAILMODELLER distribution4. These li-
braries contain tracks and accessories from various manufacturers as well as generic
elements.

In RAILMODELLER these libraries are called Railsets .

A separate application, the RAILSET EDITOR (⇒ 4) , is provided to allow editing
of existing or the creation of new railsets. Each railset contains a number of related
elements (⇒ 3.7) , such as all tracks of a particular track system for a specific
manufacturer, that provide the basic building-blocks for layouts.

3.7 Elements

The following types of elements are currently supported in a layout:

Tracks : Straight and curved tracks, flextracks, turnouts, crossings, etc.

Text : Any text in any available font, consisting of any number of lines and up to
4096 characters.

Graphics : Circles, lines, rectangles and polygons.

In your layouts the most commonly used type of element will be any type of track,
usually taken from one of the numerous supplied railsets. It is also possible to de-
sign your layout in parts or completely with generic flextracks that can be inserted
on the fly (see (⇒ 3.9.5) for details).

The following figure explains terminology used throughout this manual and in the
RAILMODELLER and RAILSET EDITOR applications.

Figure 3.3: Element terminology used in RAILMODELLER

Each element has a flag to indicate its availability status. The availability of ele-
ments is shown in the “Railset Palette” 5 (⇒ 3.3.2) as well as in the “Element
Info” dialog (“Element > Element Info” ) and uses the following three categories:

4 The complete of list of libraries currently included can be found in the appendix (⇒ A)
5 The display of element availability can be turned on or off in the “User Interface > Railset Palette”

panel of the “Preferences” .

23



In Production, Available : Flag: no flag
The track or element is still under production.

Out Of Production : Flag: small, red cross
No longer manufactured, but probably available from some dealers having
the tracks still in stock or on the second-hand market.

Obsolete : Flag: two red crosses
Elements is no longer available, e.g. because production was stopped in the
1960s.

Thus elements no longer available can be considered when planning your model
railroad empire.
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3.8 Creating New Layouts

A new worksheet is created with the “File > New Worksheet” menu command or
the “New Worksheet” toolbar button. The options in the “Preferences > Defaults
> Worksheet (1), (2)” preferences panels can be used to customize the default set-
tings always used by new worksheets, e.g. the default dimensions, whether element
names should be displayed and what grid settings should initially be used.

Figure 3.4: The “Worksheet Properties” dialog

The “Worksheet Properties” dialog (“Worksheet > Worksheet Properties” ) can be
used to control general properties of the worksheet. Parameters like the dimension
of your layout – up to 1000×1000m (or 3280×3280 feet) – or additional informa-
tion like a description or document revision can be entered in the dialog.

3.9 Working With Elements

3.9.1 Inserting Elements

The easiest way to insert a new element into the worksheet is to drag it from the
“Railset Palette” into the “Worksheet” window at the desired location.

The dragged element will snap automatically to a free joint of elements already
placed in the worksheet when the joint of the new element is close enough to the
joint of the element in the worksheet. To put it another way: Free joints behave as if
they were magnetic. The newly inserted element will then be rotated automatically
to fit to the worksheet-element it was connected to.

Once attached to an element in the worksheet the “Joint Rotate” function can be
used to change the joint of the newly inserted element used to connect to the other
element. This can be done by pressing

�� ��SPACE , using the “Joint Rotate” toolbar
button or “Element > Joint Rotate Element” .
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The following figures illustrate how the “Joint Rotate” function rotates an element
when it is called repeatedly.

H

H

H

Alternatively an element can be selected in the “Railset Palette” and then inserted
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in the layout by clicking in the worksheet at the destination position. When the
mouse-cursor is close to the selected joint it changes to an arrow to indicate that an
element can be appended as shown in figure 3.5.

Figure 3.5: Element Mä-2207 selected in the “Railset Palette” is about to be appended to Mä-2232 in
the worksheet

This functionality is only available if the element currently selected in the “Railset
Palette” has at least one joint. This means that elements like houses or trees can’t
be inserted this way.

For curved tracks inserted with the Append function the orientation of the curve is
chosen automatically. When a the curved track is appended to a (partial) circle, the
new element is automatically connected such that the circle is continued. Curved
tracks appended to straight tracks – or the straight part of a turnout – are always
rotated to continue a circle in a clockwise orientation. To append elements in a
counter-clockwise orientation

�� ��SHIFT can be pressed when appending the new
element. The cursor then displays a small “180” to indicate the alternate direction.
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The key combination
�� ��SHIFT +

�� ��OPTION deactivates the Append function temporarily. This can be
handy to move small elements without accidentally appending another element or when bending flex-
tracks (see also (⇒ 3.9.5) ).

In the “Create/Select” tool elements can be moved with the mouse to any arbi-
trary location. The precise element placement can be controlled using the “Move
Selection” (⇒ 3.9.8) and “Rotate Selection” (⇒ 3.9.9) dialogs.

Additionally several keyboard shortcuts are provided to move or rotate elements.
The table on page 56 lists all available shortcuts.

3.9.2 Limiting the Snap Angle

In the “User Interface > Various” panel of the “Preferences” dialog the option
“Limit snapping of tracks to. . . ” can be set to a number of predefined values.

This parameter controls how dragged elements snap to elements in the worksheet
during a drag operation. The parameter limits the maximal rotation-angle for the
dragged element, i.e. the maximum angle by which these elements can be rotated
when snapped to a worksheet element.

Depending on this setting RAILMODELLER decides whether elements are can snap
to each other or not during any drag operation. This constraint is required so the
drag operation can work predictably for the user6, but it can also be handy to opti-
mize your personal workflow.

3.9.3 Editing Elements

These attributes are editable for all types of elements (tracks, graphics and text):

Position : The location in the worksheet where the element is placed.
This can be changed by moving the elements with the mouse or with the
“Move Selection” (⇒ 3.9.8) dialog.

Rotation-Angle : The angle by which the element is rotated.
This can be changed with the “Element > Rotate Element” menu com-
mands, the “Rotate Selection” (⇒ 3.9.9) dialog or with the presets available
in the “Rotate Selection” toolbar button.

Color : The fill color of the element.
The “Colorize” toolbar button, the “Element > Colorize Selection” menu
command and the “Color Palette” (⇒ 3.3.5) can be used to colorize the
current selection.

Specific parameters of Flextrack-, Text-, Polygon-, Line-, Rectangle- and Circle-
Elements can be modified using the editors described in more detail in chapters

6 Consider a situation where you have 2 tracks of the same kind, one track inserted in the worksheet
and the other track dragged over the worksheet element such that it’s located on top of the other
element with an identical orientation. What joint would you expect to snap ? The application could
chose either joint and rotate the new track by +180 or −180 degrees.
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3.9.5 and 3.9.10-3.9.13. When an element is selected and an editor is available for
the type of element it can be invoked with the “Element > Edit Element” menu
command or the “Edit Element” toolbar button.

Every aspect of elements stored in railsets can be edited with the RAILSET EDITOR (⇒ 4) .

3.9.4 Selecting Elements

RAILMODELLER provides a range of functions to create selections of elements.

Please refer to the “Edit > Select” section of the “Menu” chapter (⇒ 3.4) and
the “Create/Select” tool (⇒ 3.5.1) for details!

3.9.5 Working With Flextracks

Flextracks are inserted into the worksheet by either inserting them from a railset or
by using a generic flextrack that doesn’t have to belong to any specific library using
the “Element > Insert Generic Flextrack” menu command. Like their counterparts
in the real-world flextracks in RAILMODELLER can be bend in various ways.

Any flextrack-element has either 3 or 4 control-points. Usually three control-points
are fine for most situations, however if you need to bend the flextrack to an S-
shape four control-points are required. The contextual menu for any inner control-
point allows switching between both variants by adding or deleting control-points.
Optionally open the “Flextrack Properties” dialog by editing the selected flextrack
(“Element > Edit Element” ) and choose the number of control-points there.

The shape of a flextrack can be controlled by dragging any of these control-points
around. The flextrack will automatically snap to any free joint of a track in the
worksheet and adjust it’s shape accordingly when the control-points at the end of
the flextrack are near a free joint.

Figure 3.6: Drag the first/last control-point near a free joint to automatically connect to the element.

The following restrictions apply when editing the control-points of a flextrack to
limit the shapes in RAILMODELLER to what flextracks can be bent in the real
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world:

1. The angle of a flextrack is restricted to 90 degrees.

2. The maximum length of a flextrack can’t be exceeded.

In addition to these two rules the control-point at the end of the connected flextrack
and it’s neighbour point can’t be edited when the particular end is snapped to an-
other element7. You will see a small “locker” symbol when a control-point cannot
be modified because it’s connected to another track.

These restrictions apply as well for flextracks that are created on the fly by invoking
the “Connect with Flextrack” (⇒ 3.10.5) function.

For generic flextracks the maximum length of the track and the trackbed width
can be adjusted in the the “Flextrack Properties” dialog invoked with the “Edit
Element” toolbar button or “Element > Edit Element” menu command.

These properties can’t be changed for flextracks originating from railsets. Tracks
in railsets have a fixed maximum length – i.e. the length these elements are manu-
factured and sold – and a fixed trackbed width statically defined in the railset.

The preferences option “User Interface > Various > Enable appending tracks for
flextracks” controls the behavior of the outer control-points. When the option is
activated a click on the first or last control-point of a flextrack appends an element
as described in section (⇒ 3.9.1) . If the option is turned off the outer control-
points can be dragged to edit the flextrack geometry.

This option can be turned on or off dynamically without affecting the setting of the global preferences
option with

�� ��SHIFT +
�� ��OPTION (⇒ 3.9.1) .

3.9.6 Colors

Elements inserted into the worksheet are automatically colorized with the current
default color. This color is indicated in the “Colorize” button in the toolbar and in
the default color pane of the “Color Palette” (⇒ 3.3.5) .

The color of the current selection can be set to the default color by clicking the
“Colorize” button, clicking the default color pane of the “Color Palette” while
holding

�� ��OPTION or by invoking the “Element > Colorize Selection” menu com-
mand.

A long click in the “Colorize” button of the toolbar changes the default color to
one of various pre-defined colors. An arbitrary color is chosen with the MAC OS
Color Picker. This dialog is invoked by either clicking the default color pane of the
“Color Palette” , the “Colorize” button in the toolbar while pressing

�� ��OPTION or
by using the “Element > Choose Element Color” menu command.

7 The connection angle of a flextrack is defined by the control-point at the element’s joint and it’s
neighboring control-point. So changing these particular control-points is forbidden to prevent the
connection angle of a snapped element from being modified.
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If a selection exists when changing the default color this will cause the selection to
be colorized with the new default color.

Elements can also be drawn outlined without a fill color, by choosing the No color
preset in the “Color Palette” or the “Colorize” button. This preset is depicted by
a white square with a red diagonal line.

3.9.7 Adjusting the Track Style

The style that is used to draw tracks in the currently edited worksheet can be
changed with the “Display > Track Drawing Style” dialog.

In order to understand all options and terms used by the dialog please make sure
that you’ve read the general chapter about elements in RAILMODELLER (⇒ 3.7) .

Several basic drawing styles and style options are available to customize the draw-
ing style to your personal taste. Some of the options are not available for all styles,
e.g. the “Always draw center line” option is not available when the “Plain Line”
style is selected.

3.9.8 Move Selection Dialog

The “Move Selection” dialog allows the precise positioning of elements. This
dialog is invoked using the “Element > Move To” menu command or the “Move
To” toolbar button.

The element-position can be entered with a precision of up to 1
1000 units by chang-

ing either the center-point of a selection or the top/left-edge of the (virtual) box
surrounding the selection.

3.9.9 Rotate Selection Dialog

The precise rotation angle of elements can be entered in the “Rotate Selection”
dialog. The “Element > Rotate Element > Variable” menu command or the “Ro-
tate” toolbar button invoke this dialog.

Two notations can be used to adjust the rotation-angle of the selected element. The
first notation expects the angle to be entered in degrees and minutes, a common
notation often used for the definition of angles of curved tracks by many manufac-
turers. The second variant uses the more common notation by defining an angle in
degrees and 1

10 degrees.

The “Rotation Mode” buttons can be used to specify whether the elements should
be rotated by a delta-angle or whether the angle should be interpreted as an absolute
angle.

Both options are only available when rotating single elements. Since groups of ele-
ments don’t have a common angle a selection consisting of more than one element
can only be rotated by a delta-angle.
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3.9.10 The Text Editor

The contents of a text-element can be edited using the “Text Editor” . A large text-
field allows the entry of the text directly in the “Worksheet” window. The length
of text-elements is limited to 4096 characters. This textfield automatically adapts
it’s size to match the width of the text-element when text is entered or the font or
font size is changed.

The text-style can be changed to a bold, italic or underlined appearance, the styles
can as well be combined. Additional buttons allow the specification of text-size
and the elements font.

The “Set as Default Font” checkbox can be used to set the font, which is used for
the currently edited text-element as default font. All text-elements are automati-
cally assigned the default font when they are created.

3.9.11 The Rectangle Editor

The dimensions of a rectangle-element can be adjusted using the “Rectangle Edi-
tor” . Width and height of the selected rectangle are entered in Millimetres.

In addition a short comment can be entered for the rectangle-element, that will be
displayed on top of the element if the “Display > Show Element Names” option is
turned on.
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3.9.12 The Polygon and Line Editor

The “Polygon and Line Editor” provides several functions to change the geometry
of polygon or line elements. The selected polygon can be mirrored either vertically
or horizontally and it can be scaled by an arbitrary factor.

The editor also allows to convert a polygon to a line element and vice versa by
either connecting or disconnecting the first and last point of the polygon.

Similar to the “Rectangle Editor” and “Circle Editor” a comment can be assigned
to the polygon or line element to be displayed in the worksheet if the “Display >
Show Element Names” option is turned on.
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3.9.13 The Circle Editor

A circle-element is specified by its radius in Millimetres. The precise radius can be
entered in the “Circle Editor” .

The comment for the circle-element will be displayed on top of the element if the
“Display > Show Element Names” option is turned on.

3.9.14 Some Background on Worksheet-Elements

Any worksheet is completely self-contained. This means that if you create a work-
sheet with your personal railsets, which are not included in the RAILMODELLER

distribution8, everyone can still load your worksheet because all elements are stored
in the worksheet.

Unfortunately this also means that subsequent changes made to the railset are not
immediately available in all worksheets using elements from this library.

To put it another way: Elements that have been inserted in the worksheet don’t
respond to changes made to the railset they originated from. They always contain
the information (geometry, product-nr., price, etc) that was stored in the railset
when the element was inserted in the worksheet.

For example editing the prices or descriptions of a railset doesn’t automatically
change the prices and descriptions of the elements of the same type that have
been inserted in the worksheet earlier. As bad as this seems under certain circum-
stances, it can also be of benefit. Just imagine you load the latest railset from the
RAILMODELLER website with no initial prices. All worksheets would suddenly
loose their e.g. customized pricing information.

The “Partlist” (⇒ 3.12) is the preferred way of managing the prices of elements
within worksheets.

8 Though you should submit your libraries so other users can also profit from your efforts!
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3.10 Advanced Editing Operations

3.10.1 Creating Grades and Adjusting Heights

The height of track elements can be set to any (positive) value to model multiple
height layers in your layout or simply tracks passing over or under each other.

It is also possible to easily create smooth grades ascending or descending to differ-
ent height levels.

Three functions are available under the “Arrange” menu to control the height and
grade of tracks allowing you to choose from a variety of tools the one that is the
most appropriate for your specific scenario:

Grade a Section of Tracks : This creates a grade or leveled section for the currently
selected section of tracks. The selection needs to be contiguous and contain
only simple track elements (no switches, crossings and similar elements with
more than a single track).

Create Grade to Track : Starting from the currently selected track a grade to this
track is created where the selected track is always the highest point of the
graded section.

Set Height for Tracks : All tracks connected to the currently selected track are set
to the same height.

Please note that similar to real world railroads switches and crossings can not be part of a grade. This is
also true for any other multi-track element consisting of more than 1 track element.
As the start track is always leveled a grade can however start at a switch or crossing.

The “Create Grade To Track” and “Set Height for Tracks” dialogs always operate
on a range of connected tracks: Depending on the type of grade chosen under
the Grade Profile option the function starts with the initially selected track and
continues to grade and change the heights for the tracks connected to the start track.

In contrast to this function the “Grade Section of Tracks” dialog will only affect
the currently selected section of tracks. It will in particular “rupture” connections
to tracks outside of the contiguous selection if the height of tracks doesn’t align any
more after applying a grade. Grading a selected section of tracks is straightforward:
Enter the desired height of the start and end tracks and RAILMODELLER will create
the appropriate grade and/or adjust the height for all intermediate tracks.

The “Create Grade To Track” dialog offers a number of grade profiles controlling
how the track section connected to the selected track should be modified:

Leveled Section : All tracks connected to the start track are shifted to the height
specified as maximum height. Grades, if any, are removed from the tracks so
all tracks become leveled.
An example for a “Leveled Section” type grade is shown in (⇒ 3.7) .

Up Grade : The start track is shifted to the specified maximum height. A grade is
created with all tracks connected to the left-most joint of the start track. All
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other tracks connected to the start track are shifted to the maximum height.
An example for an “Up Grade” type grade is shown in (⇒ 3.8) .

Down Grade : The start track is shifted to the specified maximum height. A grade
is created with all tracks connected to the right-most joint of the start track.
Similar to an “Up Grade” all other tracks connected to the start track are
shifted to the maximum height.
An example for a “Down Grade” type grade is shown in (⇒ 3.9) .

Up Down Grade : A combination of the “Up/Down Grade” modes: The start
track is shifted to the maximum height entered. Grades are created for all
tracks connected to the starting track.
An example for an “Up-Down Grade” type grade is shown in (⇒ 3.10) .

Figure 3.7: An example for a “Leveled Section” type grade: All connected tracks in the green track
section are shifted to the maximum height.

Figure 3.8: An example for an “Up Grade” type grade: A grade is created for the tracks connected to
the left of the selected start track and all other tracks are shifted to the maximum height.
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Figure 3.9: An example for a “Down Grade” type grade: A grade is created for the green tracks
connected to the right of the selected start track and all other green tracks set to the maximum height.

Figure 3.10: An example for an “Up-Down Grade” type grade: Only the selected start track is set to
the maximum height and grades are created for all tracks in the green track section connected to it.
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The slope of grades is limited to 100 per mille (a ratio of 1:5 or 10 per cent). In
general it is not suggested to use grades greater than 40 per mille since you might
otherwise encounter problems when operating your layout like locomotives loosing
electrical contact or failing to climb grades.
The “Create Grade To Track” dialog shows a warning if the maximum allowed
slope is exceeded.

RAILMODELLER always aims to create a smooth grade. The length of a graded
track section - or the number of tracks that are graded - depends on three factors:

1. The maximum height chosen,

2. The chosen grade,

3. The height of the tracks connected to the start track.

When RAILMODELLER creates a graded track section it grades tracks beginning at
the start track until it “finds” a leveled track at the appropriate height. Consider the
following two examples using the same settings in the “Create Grade To Track”
dialog but different initial heights for the tracks it operates on:

Figure 3.11: The first grade is created as an “Up Grade” with maximum height set to 3 Inches and all
tracks of the section initially located at height 0.

Figure 3.12: The second example shows a grade created with the same parameters entered in the “Grade
Dialog” but all tracks had an initial height of 1 Inch: Note the much shorter resulting grade.
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3.10.2 Creating Complex Grade Profiles

The previous chapter explains how to create simple graded track sections using the
various grade profiles offered in the “Create Grade To Track” dialog. Arbitrarily
complex grade profiles can be created by repeated invocations of the various grade
functions.

Let’s consider the following example: The green track section should pass over the
parallel tracks. We want the two centered green straight tracks to be leveled at a
height of 4 Inches and grades leading up and down both sides of the two tracks.

Figure 3.13: The starting situation: The green track should pass over the parallel tracks.

Since the grade function operates on all connected tracks to ensure a continuos
grade we start by temporarily disconnecting the green line.
RAILMODELLER provides various ways to achieve this, in this example we will
temporarily disconnect one of the two centered straight tracks:

Now we’re ready to create the first part of the grade: An “Up Grade” to the still
connected green straight track:

Next we reconnect the single straight track with the green line.

The two green track sections are currently on different heights. Dragging the track
back would randomly connect it to either the elevated section or the ground-level
section. To make sure the straight track connects to the ground-level section we use
“Arrange > Connect Segment to” and choose the joint of the stray straight and the
curved track of the ground-level section to connect both. Note that the two centered
straight tracks are not yet connected since they are located on different heights:

Finally we select the green straight track still located at ground-level and invoke
the “Create Grade To Track” dialog a second time to create a “Down Grade” :

RAILMODELLER will detect that both straight tracks are now on the same height
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Figure 3.14: Temporarily removing one of the two centered straight tracks.

Figure 3.15: Creating the “Up Grade” to the first straight track.

and automatically connect the tracks: The green track section is once again contin-
uously connected and now features our custom height profile.

3.10.3 Creating Track Helixes

The “Track Helix” dialog offers a simple-to-use but powerful tool for creating
track helixes.

Start by choosing “Arrange > Create Track Helix” and picking a joint where the
track helix will be appended. In the following dialog the properties of the helix
including the number of loops and overall height of the helix can be specified along
with additional parameters that influence the helix variant to be created.

Any curved track from the current railset or flex tracks of the railset bent to curved
tracks with several predefined angles can be assembled to form the track helix.
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Figure 3.16: Reconnecting the stray straight track to the the ground-level section.

Figure 3.17: A “Down Grade” starting at the second straight track completes our custom height profile.

3.10.4 Connecting Elements With Tracks

A gap between two tracks can be closed with several pieces of sectional track. Read
more about closing a gap with a single piece of flextrack in chapter 3.10.5.

The “Connect with Sectional Track” function is available in the contextual menu
of any free joint or can be invoked with the “Arrange > Connect with Sectional
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Track” menu command.

Figure 3.18: The “Connect with Sectional Track” function at work

After selecting the second joint the “Connect with Sectional Track” dialog opens
and displays the progress of the calculation. Most of the time there are several pos-
sible combinations of tracks to close a gap. The function starts with the calculation
of a connection consisting of a single track, next a connection using two tracks, up
to the maximum number of tracks specified in the “General > Connect Tracks”
panel in the preferences.

All tracks from the currently loaded railset – including bumpers, turnouts and cross-
ings – are considered for the new connection, unless the “Connect only with plain
tracks” option is turned on in the preferences. This is the default setting since
mostly it doesn’t make much sense to close a gap with a turnout or bumper.

The time required to calculate all possible solutions depends on several factors:

· the speed of your Mac

· the number of tracks in the current railset
(connections using large railsets take a longer time to calculate)

· the “Connect only with plain tracks” option
(this controls if some tracks from the current railset can be ignored)

· the maximum number of tracks to be used for the new connection

The calculation is stopped for each new connection that was found. The new con-
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nection is shown in the worksheet and the tracks that make up the connection are
displayed in the list view in the “Connect with Sectional Track” dialog. The cal-
culation of the next possible connection is started with the right arrow button.

All previously found connections can be browsed with the two arrow buttons be-
neath the list view. The connection currently shown in the dialog and the worksheet
can be inserted into the worksheet when the dialog is left with OK.

3.10.5 Connecting Elements With a Flextrack

Two elements in the worksheet can be connected with an automatically calculated
piece of flextrack. Read more about closing a gap with pieces of sectional track in
chapter 3.10.4.

The “Connect with Flextrack” function is available in the contextual menu of any
free joint or can be invoked with the “Arrange > Connect with Flextrack” menu
command. After the function has been activated all appropriate joints of elements
that have at least one free joint are highlighted. For connecting elements via flex-
tracks the restrictions described in section 3.9.5 apply.

After selecting the second joint a new flextrack element is created to connect the
two tracks. The new flextrack element can either be a generic elements or a element
from any library of a matching gauge that is long enough to connect the elements.

The following figure explains how the new joining flextrack is calculated. To join
the lower blue straight track and the green curved track using the “Connect with
Flextrack” function the elongated tracks need to intersect. In the example the
intersection point is indicated by a large red cross.

RAILMODELLER indicates the possible connections by highlighting the destina-
tion joints with yellow markers after the “Connect with Flextrack” function was
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invoked for a particular joint as described above.

If no such intersection can be calculated RAILMODELLER refuses to create the
new flextrack and displays an error message in the status bar (“Couldn’t connect
the chosen joints” followed by a short explanation).

3.10.6 Arranging Segments

A segment consists of one or more tracks connected to each other. Any segment
can be connected to any other segment using the “Connect Segment to” command
available in the contextual menu of any free joint and in the “Arrange” menu.

It is not possible to connect segments by simply dragging a group of elements to
a free joint. Only single tracks will magnetically snap to free joints while being
dragged across the worksheet.

Complex segments such as a set of switches can be reused by simply copying the
selection and reinserting the copy at the new position. Combined with the “Connect
Segment to” function complex layouts are quickly assembled.

The “Connect Segment to” function can also connect segments on different heights.
It uses a simple rule trying to preserve the grades and height profile in the segment
to be connected:

· If the selected track of the segment to be connected is located at the same
height as the destination track chosen the heights and grades of the connected
segment are preserved.

· If the destination track and the selected track of the segment have different
heights the tracks in the connected segment are shifted to match the height
of the destination track.

3.10.7 Creating and Managing Groups

A group consists of a number of elements that can be handled as a single object.
All elements of a group can only be selected or deselected, moved or rotated as a
whole. Groupings simplify tasks like arranging the worksheet and provide a simple
way of structuring the layout.

Groups can be hierarchical, i.e. a group can contain other elements as well as other
groups and any combination of the two. For example a new group can contain
another group and two single elements.
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A group is created using the “Element > Group” command or the correspondent
toolbar button. This function is available when two or more elements are selected.
The new group can either contain simple elements or other groups to build a hier-
archy of groups or both .

To dissolve a group the “Element > Ungroup” command or the correspondent
toolbar button can be used. This function is available when any group is selected.

The “Element > Ungroup All” menu command ungroups all groups in the current
worksheet. The “Worksheet Info” dialog (“File > Worksheet Info” ) provides an
overview of all groups in the current worksheet.

3.10.8 Cleaning up Orphaned Tracks

During the creation of a new layout parts of the worksheet are usually used as a
“scrapbook” for elements that are not currently needed or often copied to other
parts of the layout.

The “Cleanup Orphaned Tracks” function addresses the problem of having sin-
gle tracks in the worksheet that are not connected to any part of the layout (=
orphaned ). Instead of manually searching for these forgotten tracks the function
finds all unconnected, single tracks and deletes them.

3.11 Working with Layers

In RAILMODELLER an element is always assigned to a layer. The layer of a par-
ticular element is shown in the “Element > Element Info” dialog for the element.

Every worksheet has at least one layer9. New layers are created using the “New
Layer” icon at the bottom of the “Layer Palette” or the “Layer > New Layer”
menu item.

RAILMODELLER uses the concept of an active layer. There is always an active
layer and only one layer can be the active layer at a time. This active layer is
the layer that is currently highlighted in the “Layer Palette” window. Switch the
active layer by simply selecting a different layer in the “Layer Palette” with a
single mouse-click.

Every operation that inserts elements into the worksheet automatically assigns them
to the active layer.

Elements can be assigned manually to a specific layer using the “Layer > Assign
Selection to Active Layer” function on a selection of elements. It is worth noting
that grouped elements can only be assigned to a layer as a whole, i.e. all elements
of the group must belong to the same layer.

Layers can be locked to prevent all elements in a layer from being modified. It
is not possible to insert elements into a locked layer. Elements in a locked layer
cannot be edited, selected, moved or changed in any way. This can be handy to
protect parts of your layout temporarily or permanently from further changes.

9 RAILMODELLER supports up to 99 layers per worksheet
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A locked layer can also be very useful to contain background elements for the
layout. Benchwork, base plates or other elements that should always reside in the
background of the layout can be assigned to a locked layer. This allows them to be
always visible in the background but they will not react to mouse-clicks and can’t
be selected accidentally.

A layer can also be hidden to temporarily prevent elements in the layer from being
displayed in the worksheet. Similarly to elements in a locked layer elements in a
hidden layer cannot be edited, selected, moved or changed in any way.

Hiding a layer can be useful to focus on the part of the layout that is currently being
constructed or even to contain variations of the current layout.

Please note that the order of layers in the “Layer Palette” does not affect the ren-
dering of elements in the worksheet. The order of elements is independently han-
dled and can be changed using the “Send to Back” and “Bring to Front” functions.

3.12 The Partlist

3.12.1 General Information

Figure 3.19: The “Partlist” showing the prices for the sample worksheet.

The Partlist provides an overview of all tracks and other elements originating from
railsets that are currently used in the worksheet. It only lists elements that are
relevant for a shopping list. Decorative elements like graphics or text elements are
not included in the list.

The total number of elements and the overall price is listed on top of the list view.
The list view can be sorted by any column and the columns can also be dragged to
any arbitrary order as you are used to by the Finder.
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The availability of elements can optionally be displayed in the list depending on
the setting in the “General > Partlist” panel in the “Preferences” dialog.
For more information on element availability please check the elements chapter
(⇒ 3.7) .

A display filter can be set using the “List shows” popup-button to display either
all elements in the current worksheet (the default setting) or just the elements in the
worksheet that are not currently part of your stock. The latter option can be used
to generate a shopping list that will contain the tracks that have to be purchased in
addition to the tracks in your stock to realize the current layout.
For more information about the stock please refer to the stock chapter (⇒ 3.15) .

3.12.2 Changing Prices or Currency

The prices of worksheet elements can be edited by either clicking in the price of
a particular element or by hitting

�� ��RETURN to edit the element currently high-
lighted10.

The “Void Prices” function is supplied to set the prices of all elements in the
worksheet back to zero.

The currency can be chosen for all elements in the worksheet. Please note that
changing the currency or mixing elements with different currencies from various
railsets doesn’t affect the element-prices, i.e. RAILMODELLER doesn’t currently
perform any currency-conversions. This setting merely affects the currency dis-
played for elements and throughout the worksheet.

3.12.3 Exporting the Partlist

The partlist can be exported to a CSV11 file with tab-separated entries either

1. directly from the “Partlist” using the “Export” button, or

2. using the “Worksheet > Export Partlist” menu command

The resulting file can be opened for editing or printing in other applications like
text-editors (TextEdit, SimpleText), spreadsheet or database applications. Instead
of saving the exported partlist to a file RAILMODELLER can optionally copy the
partlist contents as plain text to the clipboard.

The partlist preferences panel provides even more options like enumerating all ele-
ments in exported partlists with a running index.

3.12.4 Synchronizing

The “Update Prices from Railsets” function checks all libraries in the Railsets
folder for the elements used in the current worksheet and updates all prices of
worksheet-elements with the prices found in these libraries.

10 To understand the effects of editing prices in the “Partlist” and the difference between editing
prices there and with the RAILSET EDITOR please take a look at section 3.9.14.

11 Character separated values, a standard widely employed by spreadsheet and database applications.
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The “Synchronize ignores empty product prices” option in the “General > Partlist”
preference panel controls whether empty prices in the libraries should be ignored
(default behavior) or copied to the worksheet-elements.

Prices differ considerably between countries or retailers, whether you buy them at your dealer or online.

This is why we have decided to leave the prices empty for most of the supplied railsets. They can
be entered for all elements of a particular railset for personal use with the RAILSET EDITOR or on a
worksheet-basis using the Price-Editor.

3.13 The 3D Mode

RAILMODELLER features a three-dimensional view of worksheets using OPENGL.

The worksheet is displayed in a full-screen window, which can be navigated using
the mouse and various keyboard shortcuts or via the 3D-Controls window. In case
you get “lost in space” or find yourself looking at the worksheet from some very
unexpected point-of-view the “Reset Point of View” button brings you back to the
initial position.

Different floor-materials can be chosen to give the scene a more realistic appear-
ance, though the performance may drop drastically on systems using older graphic-
hardware (e.g. early iBooks).

RAILMODELLER can automatically generate a terrain to match the heights and
grades of the layout. Depending on the Mac model and the size of the layout the
automatic terrain generation can take a few seconds. A “Terrain Options” dialog
allows further control over the generated terrain such as steepness and roughness.
These settings will also apply when the layout including the terrain are exported to
a SLIF file.

The preferences option “User Interface > Various > Remember viewpoint for 3D
View” can be turned on to restored the last view-settings (point of view and floor-
texture) when the 3D Mode is opened the next time. If this option is deactivated the
3D Mode always starts with the default view, i.e. looking down to the worksheet.

In 3D Mode a dedicated “3D View” menu is available. It provides access to several
options only available in the 3D Mode and can also be used to show or hide the 3D-
Controls window or exit the mode.

The following tables provide an overview of the shortcuts available in 3D Mode12.

12 Many shortcuts are also displayed as tooltips for the buttons of the 3D-Controls window.
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3.13.1 Mouse Shortcuts for 3D Mode

Click + Move Mouse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Move eyepoint up

Click + Move Mouse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Move eyepoint down

Click + Move Mouse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Move to the left

Click + Move Mouse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Move to the right�� ��OPTION + Click + Move Mouse Up . . . . . . . . . . . . . . . . Look from steeper angle�� ��OPTION + Click + Move Mouse Down . . . . . . . . . . . . . Look from lower angle�� ��OPTION + Click + Move Mouse Right . . . . . . . . . . . . . . Rotate layout counter-clockwise�� ��OPTION + Click + Move Mouse Left . . . . . . . . . . . . . . . Rotate layout clockwise�� ��SHIFT + Click + Move Mouse Up . . . . . . . . . . . . . . . . . Zoom in�� ��SHIFT + Click + Move Mouse Down . . . . . . . . . . . . . . . Zoom out

3.13.2 Keyboard Shortcuts for 3D Mode

�� ��↑ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Move eyepoint up�� ��↓ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Move eyepoint down�� ��← . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Move to the left�� ��→ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Move to the right�� ��6 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Rotate layout counter-clockwise�� ��4 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Rotate layout clockwise�� ��8 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Look from steeper angle�� ��2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Look from lower angle�� ��+ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Zoom in�� ��− . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Zoom out

3.13.3 Additional Notes

The order in which elements are drawn in the standard (2D) mode – controlled by
the “Send to Back” and “Bring to Front” functions – is ignored by the 3D Mode.
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3.14 Notes on Exporting and Printing Worksheets

3.14.1 Exporting PDF Documents

RAILMODELLER doesn’t currently directly support creating PDF documents from
worksheets. You can however use the functionality built into Mac OS X to export
PDFs via the print dialog.

Choose “File > Print” and choose appropriate settings for your layout, then con-
firm the dialog. In the subsequent Mac OS X Print dialog use the “PDF” button
in the lower left of the window to save a PDF copy of your layout.

3.14.2 Common Printing Problems

Many printer-drivers offer several levels of quality for printing graphics. It is al-
ways recommended to use the highest quality possible when printing worksheets.
Using a low quality often results in printouts where details like the grid or the
trackmarks are not visible since these are drawn using very thin lines.

If the grid is still hardly visible on a printout it is recommended to switch to the
Black/White color-scheme: “Display > Worksheet Colors > Black / White” .
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3.15 The Stock

3.15.1 General Information

The Stock represents the inventory of tracks in your possession, e.g. the contents
of the 3 boxes with LGB tracks in your attic.

The “Stock” dialog (“File > Stock” ) manages the current contents of the stock.

Basically it lists the count of items that are available for each type of element.

This dialog can be used to add or remove elements from the stock and to edit
existing stock elements. In addition it allows the import and export of the stock to
be used or edited by other applications.

Once the stock is entered in RAILMODELLER it can be used by the application
to constantly keep track of the parts from the stock already used in the currently
edited layout. This can be useful to create layouts that only use tracks from your
inventory so no additional parts have to be purchased.

It can also be useful to create partlists for your next shopping trip containing only
the new elements that are required, i.e. if the stock contains 10 straight tracks and
the layout uses 12 straight tracks the “Partlist” can be set up to list only the 2 new
straight tracks required (⇒ 3.12) .

The elements still remaining in the stock can also be displayed in the “Railset
Palette” (⇒ 3.3.2) for the layout currently edited with the appropriate preferences
settings.

The stock is stored as an XML document. The file format used by RAILMOD-
ELLER is documented in the appendix (⇒ B) .

Figure 3.20: The “Stock” dialog with a small number of tracks.
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3.15.2 Creating and Editing the Stock

New elements can be added to the stock by simply dragging them from the “Railset
Palette” to the “Stock” dialog. The count field will automatically gain focus so the
required number of elements can be entered.

An existing element can be edited by highlighting the element in the dialog. The
count of the selected element can be changed by either using

�� ��RETURN or by click-
ing the count field of the element.

3.15.3 Importing and Exporting

RAILMODELLER currently supports two file formats for importing and exporting
the contents of the stock:

1. Mac MoVe XML files

2. CSV formatted text files

Import and export with files created by Mac MoVe13 requires the Mac MoVe
database to use a specific format. A sample file is included in the Goodies/Mac
MoVe Sample folder of the RAILMODELLER distribution.

The Mac MoVe database must be exported in the XML export format to be readable
by RAILMODELLER.

The CSV import and export uses a plain text file format with three fields: Prod-
uct Number , Railset and Count . The fields are separated by the

�� ��TAB character.
CSV formatted files can be used by and edited with most spreadsheet applications
or plain text editors. They’re however not suited for most word processing applica-
tions.

In order to get a sample CSV file in the proper format it’s usually best to just export
your RAILMODELLER stock to CSV, edit the file and re-import it!

The Product Number and Railset fields must match exactly a RAILMODELLER railset and a product
number to be found in the particular railset. If no matching element can be found in the Railsets folder
the element in the list to be imported will be ignored and a warning will be issued by the application.

Optionally the number of stock elements that remain in stock for the current work-
sheet can be obtained using the “Remaining Parts” function. In order to obtain a
list of elements that must be purchased to build the current worksheet in addition
to the elements already in your stock – i.e. create a shopping list – the “Partlist”
can be used (⇒ 3.12) .

3.15.4 Multiple Stock Files

RAILMODELLER supports an arbitrary number of stocks. The default stock file,
which is automatically used when the application is started for the first time, is

13 http://mcrichter.macbay.de/Seiten/Deutsch/Macintosh/MacMoVe.htm
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located in the Library/Application Support/RailModeller folder of your home di-
rectory (e.g. Users/Steve/ ).

This file can be freely renamed, backed up or moved. The application will create
a new, empty stock file at the location specified in the “General > Stock” prefer-
ences panel. Any valid RAILMODELLER stock file can be chosen in this panel to
be used as the current stock.
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3.16 Converting Worksheets for RailModeller on Intel Macs

3.16.1 Running RAILMODELLER in PowerPC Mode

Please note that starting with Mac OS X 10.7 (Lion) Rosetta is no longer included with Mac OS X.

Worksheets created with a RAILMODELLER version prior to 3.0 are stored in a
different file format. Older file format cannot be converted by current program
versions running natively on Intel Macs. You can however force any Universal
Binary application14 to run in PowerPC mode on Intel Macs.

In order to convert old worksheets on Intel Macs please follow these simple steps:

1. Please ensure RAILMODELLER is not running

2. In Finder choose “File > Get Info” for the RAILMODELLER application
icon

3. Check the “Open using Rosetta” option as in picture (⇒ 3.21)

4. After launching RAILMODELLER the About box states that the application
running in PowerPC mode

5. Simply open and save the layouts you need to convert

6. Quit RAILMODELLER

7. Clear the “Open using Rosetta” tick

The next time RAILMODELLER is started the About box should state that the pro-
gram is running in Intel mode and the converted worksheets will work just fine.

Figure 3.21: With the “Open using Rosetta” option checked in the Finder Information dialog
RAILMODELLER will launch in PowerPC mode on Intel Macs.

3.16.2 Conversion using PowerPC-only Binaries

You can optionally download the last pre-Intel version of RAILMODELLER 3.0.x
from our archive at the RailModeller website:

http://www.railmodeller.com/old/Index.php

14 Any application on Mac OS X containing native binaries for both, Intel and PowerPC Macs is
called a Universal Binary.
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This version will always run in PowerPC mode and will thus be able to convert any
RAILMODELLER worksheet to the 3.x file format by simply opening and saving
the file.

Worksheets once saved with any 3.x version can subsequently be loaded with cur-
rent program versions on Intel Macs.

3.16.3 Other Options

If you have no longer access to a PowerPC based Mac or cannot launch RAILMOD-
ELLER in PowerPC/Rosetta mode on your Intel Mac feel free to contact us and we’ll
make sure your layouts don’t get stuck in the Pre Historic Era of Computing!
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3.17 Keyboard Shortcuts in RAILMODELLER

The following list gives an overview of the available keyboard shortcuts, which
may not have an equivalent shortcut in the menu-bar.

SHORTCUT DESCRIPTION�� ��SPACE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Joint-Rotate the selected element�� ��, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Rotate the selection -1 degree�� ��. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Rotate the selection +1 degree�� ��↑ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Move the selection 1mm up�� ��↓ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Move the selection 1mm down�� ��← . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Move the selection 1mm to the left�� ��→ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Move the selection 1mm to the right�� ��CMD +
�� ��ARROW . . . . . . . . . . . . . . . . . . . . . . Scroll worksheet left/right/up/down�� ��CMD + Mouse . . . . . . . . . . . . . . . . . . . . . . . . Arbitrarily scroll worksheet�� ��SHIFT +

�� ��ARROW . . . . . . . . . . . . . . . . . . . Move selection by 10mm�� ��OPTION +
�� ��ARROW . . . . . . . . . . . . . . . . . . Move selection by 100mm�� ��CLEAR or

�� ��DELETE . . . . . . . . . . . . . . . . . . Delete selection�� ��CTRL +
�� ��OPTION +

�� ��PAGE UP/DOWN Fast unit switch�� ��HELP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Info for the selection�� ��+ or
�� ��= . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Zoom In�� ��- . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Zoom Out�� ��TAB . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Select next element in “Railset Palette”�� ��SHIFT +

�� ��TAB . . . . . . . . . . . . . . . . . . . . . . Select previous element in “Railset Palette”�� ��OPTION +
�� ��TAB . . . . . . . . . . . . . . . . . . . . Switch to the next tool�� ��SHIFT +

�� ��OPTION +
�� ��TAB . . . . . . . . . Switch to the previous tool�� ��CTRL +

�� ��TAB . . . . . . . . . . . . . . . . . . . . . . . Show or Hide all palettes

3.18 Mouse Shortcuts for Elements in RAILMODELLER

In addition the following key combinations work when selecting elements:
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SHORTCUT DESCRIPTION

Click . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Select Element

Double-click . . . . . . . . . . . . . . . . . . . . . . . . . . . . Edit Element

Triple-click . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Select all connected tracks�� ��SHIFT + Click . . . . . . . . . . . . . . . . . . . . . . . Unselect Element�� ��CTRL + Click . . . . . . . . . . . . . . . . . . . . . . . . Open the contextual menu
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4 Railset Editor Manual

4.1 Introduction

Figure 4.1: Overview of the RAILSET EDITOR user interface.

The RAILSET EDITOR is a separate application in the RAILMODELLER distribu-
tion that allows editing existing railsets or the creation of new railsets.

The RAILSET EDITOR is not available in the demo mode of RAILMODELLER.
It will quit immediately if no license key can be found.

The RAILSET EDITOR is either launched from the Finder or by invoking the “Ele-
ments > Launch Railset Editor” menu command in RAILMODELLER.



Please make sure that you have also read section 3.9.14 discussing the dependencies
between elements in worksheets and their counterparts in railsets and section 4.7 at
the end of this chapter.

4.2 The Menus

This section gives an overview of all RAILSET EDITOR menus and a short descrip-
tion for each menu-item.

The File Menu

New Railset : Create a new railset.

Open Railset : Open an existing railset.

Open Recent : Select a recently used railset from the list.

Import Railset : Import all elements of a railset. The elements will be added to the
current railset.

Close Railset : Close the railset currently edited.

Save Railset, Save Railset As : Save the railset to disk.

The Edit Menu

Cut : Cut an active component or element

Copy : Copy an active component or element
Note that elements can be copied in RAILSET EDITOR and pasted in RAILMOD-
ELLER

Paste : Paste a component or element from the clipboard.
Note that single elements copied from RAILMODELLER can be pasted in
RAILSET EDITOR

Clear : Clear the active component or element

Unselect all : Unselect all components. This can be useful to get an overall im-
pression of the current element without highlighting any of it’s components.

The Railset Menu

Edit Properties : Edit the basic properties of the railset (4.3).

Sort Railset (A-Z) : Sort all elements of the current railset by product-number, this
variant sorts the railset in ascending order.

Sort Railset (Z-A) : Sort all elements of the current railset by product-number,
sorting by descending order.

Sort Railset (Natural) : Sort all elements of the current railset by product-number,
in contrast to the ascending variant the natural variant ignores the length of
the product-number string1.

1 Any other customized order of elements can be realized using the sort-button in the element list.
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Sort Railset by Element Type : Sort all elements of the current railset by type (plain
tracks, switches, crossings, etc.).

Find/Replace String Attributes : Brings up the Find/Replace Dialog to replace any
substring in the product-nr., description and/or manufacturer fields.

Set Current Manufacturer To All : The contents of the manufacturer-field of the
current element will be copied to all elements in the current railset.

Set Current Middle Rail Setting To All : The middle rail style of the current ele-
ment will be copied to all elements in the current railset.

Synchronize : The Synchronize functions can be used to sync changes between
two versions of a railset (⇒ 4.5)

Compare Railsets : Invokes the Railset Comparison dialog (⇒ 4.6)

The Element Menu

New Element With Straight : Append a new element to the railset with a single
straight component. See section 4.4.

New Element With Curve : Append a new element that contains a curved compo-
nent. See section 4.4.

New Element With Polygon : Append a new element to the railset with a single
polygon component. See section 4.4.

New Element With Circle : Append a new element containing a circle component.
See section 4.4.

New Element Macro : Submenu containing the following entries:

> New Crossing : Open the Crossing Dialog to enter the parameters for a new
crossing.

> New Left/Right Turnout : Creates a new left or right (or both) turnout with the
Left/Right Turnout Dialog

> New Triple Turnout : Creates a new triple turnout with the Triple Turnout Dia-
log.

> New Curved Turnout : Creates a new curved turnout with the Curved Turnout
Dialog.

> New Turntable : Open the Turntable Dialog to specify the parameters of a turntable.

> New Transfertable : Open the Transfertable Dialog to insert a new transfertable.

Import SVG-File : Import a new graphical element from a vector graphic file, see
section 4.4.7.

Duplicate Element : Make a new element based on the currently selected element.

Delete Element : Remove the currently selected element from the railset.

Select Previous Element : Edit the previous element of the railset.

Select Next Element : Edit the next element of the railset.

60



Scale Element : Invoke the Scale Element dialog for elements without track com-
ponents.

Simplify Element : Invoke the Simplify Element dialog, which tries to simplify or
reduce the size of elements.

Center All Components : Align all components of the selected element such that
their center-points overlap.

Align Components Left/Top : Align all components of the selected element to the
left and top border.

Align Components On Joint 1 : Align all components such that their Joints Nr. 1
overlap.

Align Components On Joint 2 : Align all components such that their Joints Nr. 2
overlap.

Align Components On Joints : Open the Individual Joint Alignment Dialog to pre-
cisely align particular components on their Joints.

The Component Menu

Add Straight Component : Append a straight-track component to the active ele-
ment.

Add Curve Component : Append a curved-track component to the active element.

Add Polygon Component : Append a polygon component with closed shape. De-
fault shape is a rectangle, the dimensions can be customized in the subse-
quent dialog.

Add Line Component : Append a polygon component with open shape. Default
shape is a straight or curved line, the geometry of the line can be customized
in the subsequent dialog.

Add Circle Component : Append a circle component to the current element.

Remove Active Component : Removes the currently selected component from the
active element.

Duplicate Active Component : Create a new component as a clone of the active
component.

Select Prev. Component : Select the previous component in the component-list.

Select Next Component : Select the next component in the component-list.

Rotate +90◦ : Rotate the active component clockwise by 90◦.

Rotate −90◦ : Rotate the active component counter-clockwise by 90◦.

Rotate Variable : Open the Rotate Component Dialog to specify the precise rotation-
angle for the active component.

Mirror Up/Down : Mirror the active component on the horizontal axis, e.g. for cre-
ating left variants from right variants for duplicated switch-elements.
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The Options Menu

Auto Fill-In Manufacturer : Usually all tracks of a railset belong to the same manu-
facturer. When this option is enabled the manufacturer-field of new elements
is automatically set to the manufacturer last entered.

Label Component Joints : The joints of the active component are labeled when this
option is turned on.

Mark Components Center : When enabled the center of the active component is
marked with a cross.

Outline Inactive In Editor : This option controls how components are to be drawn
in the “Element Editor” . When enabled only the active component is drawn
solid, all other components are framed. When disabled all components are
drawn solid.

Show Polypoint Index in Tooltip : Optionally display the index of the polygon point
in a tooltip when the mouse-cursor is near a polygon point in the “Element
Editor” .

Zoom Editor Window : Maximize the size of the editor-window to full-screen size.
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4.3 Creating Railsets

A new railset is created using the “File > New Library” menu command.

You’ll be asked for a filename for this railset first. This filename at the same time
specifies the name by which the railset will be known in the RAILMODELLER

application.

Pausing the mouse-cursor over any of the fields of the “Railset Properties” dialog displays a tooltip
with a short description.

In the “Railset Properties” dialog that follows the details of the new railset can be
entered. Most of these parameters can be changed later and must not be entered
when creating the railset.

The Gauge and Modelscale fields can only be changed when creating a new
railset. It’s not possible to edit these parameters for existing railsets.

Most of the fields in the “Railsets Properties” dialog should be obvious. It is not
really necessary to enter data in all fields. In addition to the Gauge and Modelscale
the following fields are mandatory:

· Trackbedwidth

· Content Type

· Element Prefix

· Description and

The Trackbedwidth is used to properly display the full trackbedwidth in RAILMOD-
ELLER with the Full Trackbed Width track style option (⇒ 3.9.7) .

The Content Type popup specifies whether the library will be shown as a track,
accessory, slot car, . . . library in RAILMODELLER.

The Element Prefix field contains a short string that can optionally be displayed for
each element of the railset in RAILMODELLER to clarify which railset the elements
belong to. This string will be printed ahead of the actual element-name for each
element in the worksheet, so it should be really short, about 2 – 4 characters.

The Description field should contain a short text describing the contents of the
railset and any additional information that may be of ultimate use for the user.

It is also a good idea to specify the following fields, if applicable:

· Manufacturer

· Manufacturer URL and Alternative URL

· Author

The Manufacturer URL and Alternative URL fields can be used to enter the loca-
tion of a website that can be opened in RAILMODELLER with a single mouse-click
from the “Railset Info” dialog.
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Figure 4.2: The “Railset Properties” dialog for an H0 railset.

Any additional information related to the railset that are not related to the railset as
such – like notes from the railset author about missing elements – can be stored in
the Comments field. This field is only visible in the RAILSET EDITOR and will
not be displayed to the user of the library in RAILMODELLER.

After closing the dialog it’s time to start populating the railset by adding elements.

4.4 Creating and Modifying Elements

4.4.1 General

Elements provide the building blocks for layouts. Elements consist of one or
more Components . Simple elements like a plain straight track contain just a sin-
gle straight component, whereas more complex tracks like turnouts and crossings
contain two or more components.

All elements of the railset currently edited in the RAILSET EDITOR are displayed in
the “Library Contents” list. When one of the elements is selected in the “Library
Contents” – i.e. is made the active element – it’s components are displayed in the
“Element Components” list.

The selected element is displayed in the “Element Editor” . All components of
the active element are shown in this editor area, the joints and the center of the
currently selected component can optionally be displayed highlighted.
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4.4.2 Components

The parameters of the component currently selected in the “Component List” can
be edited in the “Component Characteristics” .

The right part of this area adapts dynamically to the specific type of component
currently selected. For straight tracks it will contain the length and a flag whether
this track is a flextrack, for circles it will contain the radius, etc.

The left part of the “Component Characteristics” area contains common parame-
ters for each component regardless of the type of the currently edited component.
The position of a component can be given in 4 different notations, selectable by
a small popup-menu. Finally each joint of a component can be activated – to al-
low other elements to connect or snap to this particular joint – or deactivated – to
disallow other elements connecting to this joint.

The RAILSET EDITOR displays all measurements in millimetres. Internally all val-
ues are stored in millimetres in RAILMODELLER and are converted only for display
and dialogs to the current unit. This strategy works fine for the RAILMODELLER

since the precision is still absolutely fine even when converting values back and
forth e.g. to handle user input in the “Move Elements” dialog displayed to the user
in Inches. However, to allow the highest precision possible during the process of
creating and editing a railset any conversions in the RAILSET EDITOR are avoided.

The following components are available in the RAILSET EDITOR to construct
tracks and other elements:

Straight Components A component representing a straight track with a joint at each end.
Straight tracks can either be plain tracks or flextracks.

Curved Components A component representing a curved track with joints at both ends.
Note that the radius of a curved track denotes the radius measured from the
center of the track, which is the common way to denote the track radius
among most manufacturers.

Polygon Components A closed polygon shape with an arbitrary number of points.
Polygons have no joints.

Line Components A line with an arbitrary number of points.
Lines have no joints.

Circle Components A circle, specified by its diameter.
Circles have no joints.

4.4.3 Elements

The “Element Characteristics” contain various buttons to edit the properties of
the active element. Not all fields need to be filled out for every element, but when
creating railsets you should at least put information in the Product Number and the
Description fields for each element.
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Please note that the Product Number needs to be unique within a railset. The RAILSET EDITOR will
issue a warning if a duplicate Product Number is entered.

The Availability flag can be used to indicate whether elements that are no longer
or not yet in production, for details please see also section 3.7.

4.4.4 Creating Elements With Macros

It is strongly encouraged to create complex components like turnouts and crossings
with the various macros provided in the RAILSET EDITOR under the “Element >
New Element Macros > . . . ” menu.

Figure 4.3: Creating a new curve turnout with the “New Curve Turnout” dialog.

Even when the particular element is constructed slightly different and needs some
additional work it’s usually more efficient to use the macros letting RAILSET EDI-
TOR create the elements and subsequentially modify and refine the created elements
to match the specific geometry of a particular track or turnout.

Currently the following types of macros are available:

New Crossing : Creates a new crossing or double-slip turnout

New Left/Right Turnout : Creates a new left or right or both types at once

New Triple Turnout : Creates a new triple turnout

New Curve Turnout : Creates a new left or right curve turnout or both types at once

New Turntable : Creates a new turntable

New Transfer Table : Creates a new transfer table
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Figure 4.4: The “New Turntable” dialog to specify a new turntable.

4.4.5 Tools for Editing Elements

The “Alignment Tools” in the “Element” menu provide several methods for posi-
tioning the components of a particular element. Whenever possible these functions
should be used to assemble tracks instead of entering coordinates manually. The
“Alignment Tools” directly operate on the internal data-structures with the highest
precision possible.

The sophisticated “Align Components on Joints” dialog allows to align any joint
of any component to any other joint of any other component of the element, thus
providing a very convenient way of assembling complex turnouts and other com-
plicated tracks.

4.4.6 Editing Polygon Components

The RAILSET EDITOR was designed to create all common types of tracks as easily
as possible. However, due to the user-interface being tailored for the task of para-
metrically creating track elements it is not very suited to create and edit complex
polygon or line components.

It is thus encouraged to design polygon components in RAILMODELLER and im-
ported them into RAILSET EDITOR using the clipboard or to use an external vector
graphics package to create the polygon and use the capability of the RAILSET ED-
ITOR to import SVG graphics (⇒ 4.4.7) .

The current point of the polygon can be selected directly in the “Element Editor”
by clicking the point of the active polygon component. The next or previous poly-
gon point is chosen with

�� ��PAGE DOWN and
�� ��PAGE UP when the “Element Editor”

or any text input field is focussed.

Several tools are available in the “Poly-Tools” popup-menu of the “Component
Editor” when editing polygon components:

Scale : Scale the active polygon component by an arbitrary factor
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Merge : Merge the active polygon component with a second polygon component
currently in the clipboard

Round Values : Round all point coordinates of the active polygon component to
the nearest integer value

Mirror Horizontally : Mirror all points of the polygon component on the Y axis

Mirror Vertically : Mirror all points of the polygon component on the X axis

4.4.7 Importing Graphical Elements From SVG Files

The Scalable Vector Graphics (SVG) standard uses a text-based graphics language
to describe images with vector shapes, text, and embedded raster graphics. The
RAILSET EDITOR supports a subset of the SVG standard and is capable of creating
graphical elements from imported SVG files. Track elements cannot be defined
using SVG files as they are parametrically defined by their distinctive features such
as track length or angle. The RAILSET EDITOR can’t automatically extract this
information from plain graphical descriptions of tracks. Each SVG file is converted
to a single element with a component representing each SVG element of the SVG
file.

As of now only the most commonly used SVG elements are supported 2. The
support for SVG will be improved incrementally with follow-up releases of .

Release 4.1.11 of the RAILSET EDITOR supports the following SVG elements:

title element : The title of the SVG file is used as product number, if no title el-
ement is provided the filename of the SVG file is used as element name
instead.

desc element : The description is used as the element description of the imported
element. The 64-character constraint also applies to imported elements.

path element : Paths are converted to polygon or line components. The following
subset of path commands is supported in release 4.1.11:

· moveto (M or m)

· closepath (Z or z)

· lineto (L, l, H, h, V or v)

· Cubic Bezier command (C or c)

· Quadratic Bezier command (Q or q)

rect element : Rectangles are converted to polygons components. Plain and rounded
rectangles are supported.

line element : Lines are converted to polygons components.

circle element : SVG circles are converted to circle components.

2 Contact MacRailSoft if you have any problems with particular SVG files.
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polygon element : Polygon elements are converted to polygon components (closed
polygons).

polyline element : Polylines are converted to polygon components (line segments).

We recommend Inkscape, a popular and powerful free vector graphics editor for creating SVG files.
SVG files written by Inkscape work best in RAILSET EDITOR when the Plain SVG format is used!

4.5 Synchronizing Railsets

Two versions of the same railset can be synchronized with the “Synchronize Prices”
and “Synchronize Descriptions” functions.

When the function is invoked, it displays a dialog to select a different version of
the currently edited railset. This second railset – the synchronization source –
can e.g. contain element prices entered earlier that should be copied to the current
version of the railset.

The synchronization compares product-numbers in both railsets to find similar ele-
ments. These pairs can then be synchronized in two ways:

“Synchronize Prices” : Update all prices of the railset currently edited with the
prices of the synchronization source

“Synchronize Descriptions” : Change all element descriptions of the current railset
to the descriptions of the synchronization source

Once the synchronization source has been chosen the “Synchronize” dialog is
displayed. The dialog shows a preview of the total number of elements contained
in the synchronization source, the number of matching elements (identical product-
nr) and the number of elements that will be updated.

The synchronization operation is finally performed using the “Synchronize Now”
button of the “Synchronize” dialog.

4.6 Comparing Railsets

The “Compare Railsets” function allows two different versions of the same railset
to be compared. The comparison reports elements that are added to or deleted from
a railset and elements that have been modified. All differences on

1. Railset level
(e.g. different descriptions or URLs)

2. Element level
(e.g. different prices or number of components)

3. Component level
(e.g. different length of straight components)
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Figure 4.5: The “Compare Railsets” dialog.

will be reported for the railset elements.

The railset currently edited is compared with a second version of this railset. Simi-
lar to the “Synchronize” dialogs the “Compare Railsets” function asks for a com-
parison railset when it’s invoked. The results of the comparison operation are dis-
played in the “Compare Railsets” dialog.

Each element with different data in each railset is indicated with a small yellow
dot next to its product number. A detailed report of the differences for a specific
element is displayed by selecting the element in the list.
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4.7 A General Note for Railset Creators

When creating and editing elements it is always a good idea to verify whether the
elements are specified correctly. There are even cases where the manufacturer-
information doesn’t match the actual geometry of the tracks.

In either case any edited railset should be verified in RAILMODELLER using the
geometry-examples given by almost every manufacturer. If you have difficulties
reproducing the examples there are most likely errors in the geometry of some of
your tracks.

The Goodies/Various Sample Plans folder contains several sample worksheets that
have been created to verify various railsets that are included in the RAILMOD-
ELLER distribution.
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4.8 Keyboard shortcuts in RAILSET EDITOR

4.8.1 General Shortcuts

SHORTCUT DESCRIPTION�� ��+ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Zoom In�� ��- . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Zoom Out�� ��> . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Sort Railset Ascending�� ��< . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Sort Railset Descending�� ��CMD +
�� ��↑ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Select previous element�� ��CMD +
�� ��↓ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Select next element�� ��CMD +
�� ��← . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Select previous polygon point�� ��PAGE UP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Select previous polygon point

Select previous list element�� ��CMD +
�� ��→ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Select next polygon point�� ��PAGE DOWN . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Select next polygon point

Select next list element

4.8.2 Element Editor Shortcuts

The following shortcuts are only valid for the “Element Editor” .

SHORTCUT DESCRIPTION�� ��CTRL +
�� ��ARROW . . . . . . . . . . . . . . . . . . . . . . . . . Move the active component by 1mm�� ��SHIFT +
�� ��CTRL +

�� ��ARROW . . . . . . . . . . . . . Move the active component by 10mm�� ��OPT +
�� ��CTRL +

�� ��ARROW . . . . . . . . . . . . . . . Move the active component by 100mm�� ��, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Rotate by -1 degree�� ��. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Rotate by +1 degree�� ��PAGE UP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Select previous polygon point�� ��PAGE DOWN . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Select next polygon point
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5 Registration

RAILMODELLER is distributed as shareware, which means that you can freely try
out the demo version to see whether it satisfies your expectations.

If you’d like to purchase the program you’ll receive a personal license key after
paying the shareware fee. This license will unlock the demo version and enable the
Save, Export and Print functionality not available in the demo (⇒ 2) .

Please note that the demo comes with the same features as the full version. In
particular the full version does not include any additional libraries or other bonus
material not available in the demo version.

RAILMODELLER can be purchased online at the Kagi e-commerce store.

To pay the shareware-fee of EUR 29,- or US $ 39,-1 via KAGI please visit

I http://order.kagi.com/?1RN&lang=en

You will receive a personalized license key unlocking the demo version via email.

Please note that your personalized license key will be created manually. Unfortu-
nately it is currently not possible to instantly ship the keys. You will receive your
license key within the next 48 hours, but usually much faster.

The information you supplied at Kagi will be used to create your personal license
key. If you need to correct or complete the registration information (name, ad-
dress, etc.) you can send an email to support@railmodeller.com with the
updated data immediately after purchasing the program at KAGI.

Please note that license keys cannot be updated once delivered to you.

1 Note that VAT may apply depending on your country of residence.



6 Contact

In case you have any questions, suggestions, feature requests, or if you would like
to submit new or updated railsets or worksheets feel free to contact us via email at
support@railmodeller.com.



7 Reporting Bugs

If RailModeller stops unexpectedly Mac OS X will write a Crash Log in the Logs
folder in the Library folder of the user’s home directory. The log will have a file-
name like “RailModeller.crash.log” and can be found easily using the Search facil-
ity (also known as Spotlight) of the Finder.

We would appreciate if you could send us an email describing the situation and
actions leading up to the crash and attach the RailModeller.crash.log to your email.

Please send the email to support@railmodeller.com - this will help us correcting
the bug for the next release of RailModeller!



Appendix A Libraries Included in Release 4.1.11

This release of RAILMODELLER contains 226 libraries.

LIBRARY # VERSION COMMENTS

Z (1:220)
Maerklin Z 35 (Sep 10. 2011, 09:13:40)
Mrklin Z English 32 (Sep 8. 2009, 09:30:04)
Peco Z 1 (May 14. 2007, 22:14:01)
Rokuhan Z 55 (Jun 4. 2015, 18:19:12)
Maerklin Z Lokschuppen 2 (May 14. 2007, 22:13:21) Edbert van Eimeren
Mrklin Z Accessories 33 (Nov 1. 2015, 11:47:33) Brian Redman
Trees Z 25 (May 14. 2007, 22:13:30)
Trackplan Symbols Z 45 (May 14. 2007, 22:13:36) Edbert van Eimeren / MacRailSoft

N (1:160)
Arnold N 43 (May 14. 2007, 22:07:07)
Atlas N Code 55 47 (Jul 7. 2015, 17:59:03)
Atlas N Code 80 35 (Jan 19. 2012, 15:19:08)
Bachmann E-Z Track N 22 (Nov 25. 2011, 08:54:04)
Fleischmann N 45 (Feb 3. 2009, 19:54:27)
Hornby N 36 (May 14. 2007, 22:08:12) MacRailSoft / Edbert van Eimeren
Kato Unitrack N 126 (Sep 6. 2015, 12:33:32) MacRailSoft / Edbert van Eimeren
Kato Unitram 10 (Mar 30. 2015, 16:47:13)
Micro Engineering N Code 55 7 (Sep 3. 2015, 07:01:00)
Micro Engineering N Code 70 5 (Sep 3. 2015, 07:01:17)
Minitrix 42 (Feb 1. 2012, 19:43:41)
Peco N Finescale 18 (Oct 25. 2013, 18:48:58) MacRailSoft / van Eimeren / Fredrik Brutigam
Peco N Finescale GB 16 (May 14. 2007, 22:09:16) Edbert van Eimeren modified by Frank Bryant
Peco N SeTrack 18 (Nov 10. 2013, 08:56:40) Edbert van Eimeren / MacRailSoft
Peco N Streamline 16 (Apr 11. 2015, 11:07:30) Edbert van Eimeren
PIKO N 20 (May 14. 2007, 22:10:17)
Roco N 40 (May 12. 2014, 17:33:32)
Tomix N 98 (Oct 31. 2015, 08:49:19) Edbert van Eimeren / MacRailSoft
Tomix N Special 32 (Oct 31. 2015, 08:39:01) Edbert van Eimeren
Tomix N Tram 14 (Oct 31. 2015, 08:56:05) Edbert van Eimeren
Various Turntables N 9 (Jun 6. 2012, 10:28:54) Edbert van Eimeren
Brawa N 9 (May 13. 2007, 11:43:17)
Trees N 25 (May 13. 2007, 11:43:28)
Various Roundhouses N 3 (Jun 2. 2015, 20:53:54) Edbert van Eimeren
Aurora Bus Track 13 (May 13. 2007, 11:44:04) Heinrich Koenig
Layout Test N 15 (May 12. 2008, 20:59:13) Edbert van Eimeren
Trackplan Symbols N 48 (May 13. 2007, 11:44:33) Edbert van Eimeren

TT (1:120)
Kuehn TT 15 (Jan 12. 2013, 12:14:44)
Tillig TT Bettungsgleis 27 (Apr 10. 2015, 17:37:03) MacRailSoft / van Eimeren



Tillig TT Modellgleis 49 (Apr 6. 2015, 16:34:20) MacRailSoft / van Eimeren
Tillig TT Standard 26 (May 14. 2007, 22:13:10)
Trees TT 25 (May 14. 2007, 22:12:00)
Trackplan Symbols TT 47 (May 14. 2007, 22:12:08) Edbert van Eimeren / MacRailSoft

H0e (1:87)
Bemo H0e 10 (May 12. 2007, 17:12:32) Edbert van Eimeren
Egger H0e 10 (May 26. 2013, 17:57:01) Hans Svensson
Peco H0e 5 (May 12. 2008, 20:57:55) Edbert van Eimeren
Roco H0e 12 (May 12. 2007, 17:22:15) Edbert van Eimeren
Tillig H0e 3 (May 12. 2007, 17:24:03) Edbert van Eimeren

H0m (1:87)
Bemo H0m Code 70 16 (May 12. 2007, 17:12:49) Edbert van Eimeren
Bemo H0m Standard 27 (May 12. 2007, 17:13:04) Edbert van Eimeren
Peco H0m 9 (May 12. 2007, 17:20:41) Edbert van Eimeren
Tillig H0m 3 (May 12. 2007, 17:24:10) Edbert van Eimeren

H0 (1:87)
Peco 00-9 Setrack 11 (Feb 21. 2015, 17:01:26)
Atlas H0 Code 100 43 (Mar 30. 2015, 18:44:48)
Atlas H0 Code 83 47 (Aug 10. 2015, 21:21:06)
Bachmann E-Z Track H0 33 (Sep 16. 2011, 17:09:10)
Busch Feldbahn 9 (Mar 24. 2014, 19:07:18)
Fleischmann H0 Modellgleis 37 (Mar 18. 2012, 16:52:55)
Fleischmann H0 Profigleis 48 (Aug 17. 2009, 10:23:36)
Frateschi 18 (Sep 12. 2010, 17:06:41) MacRailSoft / Marcus Vinicius Ferreira
Kato Unitrack H0 43 (Apr 4. 2014, 20:43:13) Edbert van Eimeren
Klein Modellbahn H0 38 (May 12. 2007, 17:14:45) Edbert van Eimeren
Kleinbahn H0 42 (Apr 4. 2014, 20:52:03) Edbert van Eimeren
Lima H0 NEM120 19 (May 12. 2007, 17:15:07) Edbert van Eimeren
LUNA Tram 32 (May 26. 2013, 16:21:41)
Maerklin H0 C 47 (Oct 28. 2015, 07:34:55)
Maerklin H0 C English 40 (Sep 10. 2011, 08:54:14)
Maerklin H0 K 54 (Apr 6. 2015, 16:48:51)
Maerklin H0 K English 55 (Feb 13. 2009, 18:06:01)
Maerklin H0 M 52 (Sep 10. 2011, 08:58:13)
Maerklin H0 M English 45 (Jun 8. 2007, 17:33:50)
MBT-Hof Tramline H0 23 (May 26. 2013, 17:52:25) Edbert van Eimeren
Mehano H0 12 (May 12. 2007, 17:17:34)
Peco H0 Code 83 US 11 (Feb 10. 2008, 18:00:26) Edbert van Eimeren
Peco H0 Finescale 18 (May 12. 2008, 20:57:44) Edbert van Eimeren
Peco H0 SeTrack 22 (Feb 18. 2015, 18:00:50) Edbert van Eimeren
Peco H0 Streamline 21 (May 12. 2008, 20:57:23) Edbert van Eimeren
PIKO A 31 (Sep 12. 2008, 10:26:28)
Roco geoLINE 21 (May 18. 2007, 04:20:21) MacRailSoft / Edbert van Eimeren
Roco Line H0 52 (May 12. 2007, 17:22:30) Edbert van Eimeren
Roco Line H0 shortcut 54 (May 12. 2007, 17:22:41) Edbert van Eimeren
RocoLine H0 mit Bettung 42 (May 12. 2008, 20:58:21) Edbert van Eimeren
Shinohara H0 Code 70 16 (May 12. 2007, 17:23:35) MacRailSoft / Edbert van Eimeren
Tillig H0 Elite Code 83 58 (Apr 10. 2015, 18:02:11)
Tillig H0 Standard Code 100 35 (May 12. 2007, 17:23:55) MacRailSoft / Edbert van Eimeren
Trix Express H0 28 (May 12. 2007, 17:24:21) Edbert van Eimeren
Trix H0 C 34 (Aug 31. 2015, 13:59:21) MacRailSoft / Edbert van Eimeren
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Trix International H0 26 (May 12. 2007, 17:24:54) MacRailSoft / van Eimeren
Various Turntables H0 12 (Nov 12. 2014, 19:30:13) Edbert van Eimeren
Weller H0 24 (Jan 12. 2014, 13:25:54) Edbert van Eimeren
Atlas H0 C100 Bridges 7 (Feb 3. 2012, 14:22:12)
Atlas H0 C83 Bridges 5 (Feb 3. 2012, 14:25:50)
Brawa H0 21 (May 12. 2007, 17:10:08)
Fleischmann H0 Zubehoer 4 (May 12. 2007, 17:10:14) Edbert van Eimeren
Generic Houses H0 21 (May 12. 2007, 17:10:18)
Maerklin H0 Bruecken 17 (May 12. 2007, 17:10:28) Edbert van Eimeren
Maerklin H0 Zubehoer 11 (Oct 28. 2015, 07:40:18)
Trees H0 25 (May 12. 2007, 17:10:38)
Various Roundhouses H0 12 (Jun 2. 2015, 20:57:20) Edbert van Eimeren
HO Slotcar 48 (May 12. 2007, 17:11:09) Matt Wolanski
Tomy AFX HO 16 (Mar 23. 2014, 16:31:07) Paul J Tetreault Jr / MacRailSoft
Layout Test H0 15 (May 12. 2008, 20:58:56) Edbert van Eimeren
Trackplan Symbols H0 54 (Jan 8. 2012, 14:38:15) Edbert van Eimeren / MacRailSoft

00 (1:76)
Hornby 00 32 (Sep 20. 2015, 17:16:47)
Trees 00 25 (May 12. 2007, 16:58:58)
Trackplan Symbols 00 47 (May 12. 2007, 16:59:17) Edbert van Eimeren / MacRailSoft

S (1:64)
S-Trax 15 (Jun 30. 2014, 17:51:29)
Universal Track 15 (May 14. 2007, 22:11:48)
Trees S 25 (May 14. 2007, 22:11:19)
Trackplan Symbols S 47 (May 14. 2007, 22:11:29) Edbert van Eimeren / MacRailSoft

0 (1:45)
Atlas 0 21st Century 2-Rail 19 (Jan 21. 2009, 18:35:26) MacRailSoft & Arthur Howes
Atlas 0 21st Century 3-Rail 74 (May 24. 2015, 21:58:11) MacRailSoft & Arthur Howes
Atlas 0 Industrial Rail 3-Rail 14 (Jan 21. 2009, 19:01:00) MacRailSoft & Arthur Howes
ETS Spur 0 18 (May 12. 2007, 16:53:50) Edbert van Eimeren
ETS Tram 0 9 (May 12. 2007, 16:53:59) Edbert van Eimeren
Faller E-Train 9 (Feb 9. 2014, 12:16:14) Ulf Henrich
Faller Playtrain 6 (Jan 23. 2011, 11:29:54) Ulf Henrich
LEGO Duplo 4 (Jan 23. 2011, 11:24:21) Ulf Henrich
Lenz Spur 0 22 (Mar 18. 2012, 15:24:41) Edbert van Eimeren / MacRailSoft
Lionel 0 16 (May 1. 2009, 21:19:41) MacRailSoft & Arthur Howes
Lionel 0-27 18 (May 1. 2009, 21:13:48) MacRailSoft & Arthur Howes
Lionel FasTrack 67 (Sep 9. 2015, 18:43:30) Arthur Howes
Lionel Super O 10 (Nov 30. 2012, 14:20:08) Anthony Potts
MTH RealTrax 31 (Oct 20. 2015, 17:13:35)
Peco 0 FlatBottom 3 (May 12. 2007, 16:57:52) Edbert van Eimeren
Peco 0 Streamline 10 (Sep 7. 2015, 18:29:53) Edbert van Eimeren
Peco 0e 5 (May 12. 2008, 21:00:09) Edbert van Eimeren
Roco Om 24 (May 12. 2007, 16:58:30) Edbert van Eimeren
Roco Spur 0 5 (May 12. 2007, 16:58:38) Edbert van Eimeren
Ross Custom Switches 109 (Aug 31. 2015, 15:34:01)
Various Turntables 0 2 (May 12. 2007, 16:58:47) Edbert van Eimeren
Trees 0 25 (May 12. 2007, 16:52:24)
Trackplan Symbols 0 47 (May 12. 2007, 16:52:38) Edbert van Eimeren / MacRailSoft

I (1:32)
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Huebner 1 32 (Sep 9. 2009, 08:43:08) Edbert van Eimeren
Huebner 1e 14 (May 12. 2007, 17:26:33) Edbert van Eimeren
Maerklin Spur 1 44 (Jun 14. 2015, 11:27:11)
Peco 1 3 (May 12. 2007, 17:26:53) Edbert van Eimeren
Peco 1m 5 (May 12. 2008, 21:00:21) Edbert van Eimeren
Thiel Spur 1 3 (May 14. 2007, 22:04:35)
Various Turntables 1 2 (May 12. 2007, 17:27:09) Edbert van Eimeren
Trees I 25 (May 12. 2007, 17:25:23)
Trackplan Symbols I 47 (May 12. 2007, 17:25:42) Edbert van Eimeren / MacRailSoft

IIm / G (1:22,5)
Aristocraft Brass 28 (Feb 24. 2009, 19:58:35)
Aristocraft Euro 26 (Feb 24. 2009, 20:01:59) MacRailSoft / van Eimeren
Aristocraft Steel 28 (Feb 24. 2009, 20:04:55) MacRailSoft / Andrew W. Smith
GMTS 22 (May 12. 2007, 17:30:33) Bernd Lohrum
Heyn Feldbahn 45mm 59 (Nov 14. 2013, 19:53:38) Edbert van Eimeren / MacRailSoft
Lebu IIm 18 (May 12. 2007, 17:31:12)
LGB 43 (Feb 23. 2009, 20:57:29) MacRailSoft / Edbert van Eimeren
LGB-Nickel 37 (May 12. 2007, 17:31:37) MacRailSoft / Edbert van Eimeren
Lotus Lokstation 9 (May 12. 2007, 17:31:47) MacRailSoft / Edbert van Eimeren
Peco IIm 7 (May 12. 2007, 17:32:02) Edbert van Eimeren
Piko G 27 (Sep 11. 2013, 19:21:22) MacRailSoft / Spur-G-Blog.de
Regner-Feldbahn 12 (May 12. 2007, 17:32:23) Edbert van Eimeren
Revalda IIm 26 (May 12. 2007, 17:32:51)
Thiel IIm Messing 38 (May 14. 2007, 21:56:24) Edbert van Eimeren
Train Line 45 36 (Mar 1. 2015, 12:33:30) MacRailSoft / Spur-G-Blog.de
Train Line 45 Obsolete 17 (Mar 23. 2014, 18:35:12)
Various Turntables IIm 1 (May 12. 2007, 17:33:28) Edbert van Eimeren
LGB Bruecken 2 (May 12. 2007, 17:27:45) Edbert van Eimeren
LGB Zubehoer 28 (May 12. 2007, 17:27:56) Edbert van Eimeren
Lokschuppen IIm 2 (May 12. 2007, 17:28:02) Edbert van Eimeren
Trees II 25 (May 12. 2007, 17:28:07)
Trackplan Symbols II 47 (May 12. 2007, 17:28:36) Edbert van Eimeren / MacRailSoft

Custom Scale
Faller Play Street 12 (May 12. 2007, 17:05:45) Edbert van Eimeren
Aristocraft Transit System 8 (May 12. 2007, 17:07:32)
Brio 21 (May 12. 2007, 17:07:44)
Fenbo 10 (Oct 25. 2013, 18:51:20) Rick Osman
LEGO 12V Grey 5 (May 29. 2012, 10:15:05) Alain le Sage
LEGO 9V 6 (Jan 15. 2012, 15:23:24)
LEGO Monorail 10 (Jun 19. 2012, 10:00:28) Alain Le Sage
Mega Bloks 5 (Oct 25. 2013, 18:52:23) Rick Osman
Peco SM-32 9 (Jun 30. 2013, 18:36:47)
Plarail Tomy 21 (Oct 25. 2013, 18:54:22) Rick Osman
Playmobil RC Train 9 (May 12. 2007, 17:08:09)
Standard Gauge (Tinplate) 14 (May 12. 2007, 17:08:30) Charles L. Grover
Standard Gauge Track 10 (May 29. 2012, 09:22:05)
TGauge 35 (Feb 5. 2015, 19:38:37)
Tomy Trackmaster 8 (Mar 3. 2009, 22:00:06) Max Stone
Rahmenteile 14 (May 12. 2007, 17:00:05) Edbert van Eimeren
Artin 14 (Nov 25. 2011, 08:54:34)
Carrera Exclusive + Evolution 53 (May 12. 2008, 20:53:03) Edbert van Eimeren / Daniel Garcia Muoz
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Carrera Go!!! 26 (Jan 18. 2010, 13:28:47) Ulf Henrich
Carrera Pro-X 9 (May 12. 2007, 17:05:16) Edbert van Eimeren
Faller AMS 46 (May 12. 2007, 17:05:26) Edbert van Eimeren
Faller Car System 12 (May 1. 2015, 17:19:51)
Faller Laser Street 30mm 6 (May 6. 2015, 18:47:28)
Faller Laser Street 50mm 12 (Sep 28. 2015, 16:51:37)
Fleischmann RMC 17 (May 12. 2007, 17:05:53) Edbert van Eimeren
Maerklin Sprint 20 (May 12. 2007, 17:06:00) Edbert van Eimeren
Ninco Slotcar 46 (Sep 17. 2012, 11:32:56) Edbert van Eimeren / MacRailSoft
Scalextric 31 (May 12. 2007, 17:06:17) MacRailSoft / Edbert van Eimeren
Scalextric Digital 12 (Oct 2. 2015, 08:07:16)
Scalextric Sport 20 (Oct 2. 2015, 08:08:49) Paul J Tetreault Jr
Scalextric Sport RJ 38 (May 18. 2015, 18:05:53) Richard Z. Jucha
Arnold-Digital 9 (May 12. 2008, 20:52:47) Edbert van Eimeren
Bachmann Digital 5 (Feb 10. 2008, 17:58:45) Edbert van Eimeren
Computers + Accessories 7 (Sep 23. 2009, 10:11:19)
Digitrax Digital 10 (Feb 10. 2008, 17:58:40) Edbert van Eimeren
ESU Digital 11 (May 12. 2008, 20:53:16) Edbert van Eimeren
Fleischmann-Digital 13 (May 12. 2007, 17:01:42) Edbert van Eimeren
Fleischmann-FMZ 10 (May 12. 2007, 17:00:48) Edbert van Eimeren
Fleischmann-Stellpult 25 (May 12. 2007, 17:00:53) Edbert van Eimeren
Heki-Stellpult 45 (May 12. 2007, 17:00:58) Edbert van Eimeren
Hornby Digital 4 (Feb 10. 2008, 17:58:31) Edbert van Eimeren
LDT Digital 19 (May 12. 2007, 17:02:05) Edbert van Eimeren
Lenz-Digital 35 (May 12. 2007, 17:02:10) Edbert van Eimeren
LGB-Digital 21 (May 12. 2007, 17:02:17) Edbert van Eimeren
LGB-Electric 21 (May 12. 2007, 17:01:15) Edbert van Eimeren
Maerklin-Digital 41 (Nov 1. 2015, 11:39:41) Edbert van Eimeren / MacRailSoft
Maerklin-Digital = 9 (May 12. 2007, 17:01:24) Edbert van Eimeren
Maerklin-Digital Alt 7 (May 12. 2007, 17:02:35) Edbert van Eimeren
Maerklin-Systems 18 (Sep 1. 2009, 11:27:03) Edbert van Eimeren / MacRailSoft
Massoth Digital 23 (May 12. 2007, 17:02:52) Edbert van Eimeren
Roco-Digital 24 (May 12. 2008, 20:53:45) Edbert van Eimeren
Roco-Stellpult 41 (May 12. 2007, 17:03:07) Edbert van Eimeren
SES-Stellpult 146 (May 12. 2007, 17:03:27) Edbert van Eimeren
Stellpult allgemein 30 (May 12. 2007, 17:03:35) Edbert van Eimeren
Tams Digital 14 (May 12. 2008, 20:53:32) Edbert van Eimeren
Tillig-Digital 14 (May 12. 2007, 17:03:52) Edbert van Eimeren
Tran Digital 4 (Feb 10. 2008, 17:58:18) Edbert van Eimeren
Transformer 3 (Oct 25. 2013, 20:45:11) Edbert van Eimeren
Trix-Digital 16 (May 12. 2007, 17:04:02) Edbert van Eimeren
Trix-Digital Alt 12 (May 12. 2007, 17:04:21) Edbert van Eimeren
Trix-Stellpult 44 (May 12. 2007, 17:04:28) Edbert van Eimeren
Uhlenbrock-Digital 35 (May 12. 2007, 17:04:38) Edbert van Eimeren
Various Digital 3 (May 12. 2007, 17:04:44) Edbert van Eimeren
Zimo Digital 22 (Jan 23. 2011, 18:42:56) Edbert van Eimeren

The number of railsets is constantly growing and existing libraries are updated on a regular basis. Please
visit the RAILMODELLER website for the latest updates!
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Appendix B The Stock File Format

The stock is saved in an XML-based file format that can be read with a dedicated
XML editor or any plain text editor.

A sample stock could look like this:

<?xml version="1.0" ?>
<RailModeller_Stock>

<StockItem>
<ProductNr>2-111</ProductNr>
<Railset>Kato Unitrack H0</Railset>
<Count>10</Count>

</StockItem>
<StockItem>

<ProductNr>50200</ProductNr>
<Railset>Roco Om</Railset>
<Count>23</Count>

</StockItem>
</RailModeller_Stock>

The following table describes the XML tags used.

RailModeller Stock Mandatory root node

StockItem Includes a single stock item

ProductNr A product number uniquely identifying the element in the railset

Railset The name of the elements railset

Count Number of elements of this type in stock



Appendix C The Simple Layout Interchange Format

The Simple Layout Interchange Format (SLIF) contains a representation of the
track geometries in a layout. It is a based on the XML file format. Third party
applications can import SLIF files for further processing.

The SLIF specification is available upon request.



Appendix D Program History

Changes in 4.1.11
(1. November 2015)

. RAILMODELLER

· Update check working again
· The ’Connect with Sectional Tracks’ function would not properly work with tracks on height other than 0
· Small gauges (N and smaller) could cause ’Connect with Sectional Tracks’ to not find track connections

Changes in 4.1.10
(14. April 2014)

. RAILMODELLER

· Update check working again on OS X Mavericks
· Direct link to the user gallery added to the Help menu
· Larger preset font sizes added
· Default file name for exported images prefixed
· Path to the stock now displayed in the Preferences dialog

Changes in 4.1.9
(15. November 2013)

. RAILMODELLER

· Improved compatibility with OS X Mavericks
· Fixed a rare issue with printouts having an incorrect scale
· The Railset Editor could cause an error message on Mavericks

Changes in 4.1.8
(26. October 2013)

. RAILMODELLER

· Compatible with OS X Mavericks
· Flex tracks could become inactive and not react to mouse clicks after a “Bend to Curve” or “Bend to Straight”

operation in the Flex Track Editor

Changes in 4.1.7
(10. May 2013)

. RAILMODELLER

· Fixed an issue where the user interface could lock up following a cancelled “Connect With..” operation
· “Connect sectional tracks” now considers more potential track connections to find more solutions
· Fixed a potential crash where layers where still shown after a worksheet was already closed
· No longer attempting to automatically locate an old license file when launched for the first time as it does poten-

tially take a long time

Changes in 4.1.6
(05. October 2012)

. RAILMODELLER

· Improved compatibility with Mac OS X 10.8 (Mountain Lion)
· Fixed an issue where users could save files with a slash character in the filename
· Using “Zoom to fit” with very large (>100m) layouts could cause an error message
· Better integration of worksheets with Finder Search and Get Info display
· Cosmetic issues with bubbles displayed in “Connect with” functions fixed



Changes in 4.1.5
(18. March 2012)

. RAILMODELLER

· New function to reset height of selected tracks to 0
· New function to hide all except the active layer
· Fixed a crash with the tape measure tool

Changes in 4.1.4
(5. March 2012)

. RAILMODELLER

· Graded sections with non-contiguous grades could be created in certain scenarios
· Relaxed rules for connecting tracks taking into account individual track gauges and a configurable factor
· Improved behaviour of the tape ruler tool for areas dense with track joints
· Shortening a flex track could result in areas of the flex track not responding to mouse clicks
· The Connect With Tracks calculation could run out of memory and crash the application in certain scenarios
· Fixed an issue when exporting SLIF files with non-roman characters in the file name
· Fixed a crash in the demo version when attempting to export an image

Changes in 4.1.3
(15. January 2012)

. RAILMODELLER

· Grading a section could result in an application error message
· Bubbles highlighting source and candidate joints for track connections and grades were sometimes not displayed

Changes in 4.1.2
(27. November 2011)

. RAILMODELLER

· An error in english and german localizations resulted in wrong strings displayed throughout the application
· Prevent multiple layers having identical names
· Track heights could be printed at a tiny size when display of element names was switched off
· Fixed an error with misplaced track heights occuring at random locations in printouts
· Grading a section of non-contiguous tracks could result in an error message
· The Helix dialog could cause a crash when invoked repeatedly
· Fixed a crash in the Preferences dialog

Changes in 4.1.1
(15. November 2011)

. RAILMODELLER

· Element names were not visible on some 10.7 systems
· Fixed a rare problem where installing the license key could fail due to an existing, corrupted license file in the

RailModeller ’Software License’ folder
· Enhanced SLIF file format

Changes in 4.1
(9. September 2011)

. RAILMODELLER

· New “Grade section of tracks” function allows easy grading of a selected track section
· The track helix function now supports creating track helixes with curved flex tracks
· The “Create Grade” function has been conveniently split into dedicated “Create Grade to Track” and “Set

Height for Tracks” functions
· New “Show All Layers” command
· Snapping to tracks can be disabled in the tape ruler tool by holding down the CMD key
· The “Bend to Straight” function for flex tracks with 4 control points could result in flex tracks that were no longer

editable by hand
· Pasting elements now assigns them to the active layer
· Streamlined license installation process
· Quick link to the tutorial videos added to the Help menu
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Changes in 4.0.2
(8. February 2011)

. RAILMODELLER

· New Terrain Options allow customization of steepness, roughness and resolution of the auto-generated terrain
· Improved performance for terrain generation and SLIF export
· Improved 3D view performance for terrain display
· Terrain could conceal parts of tracks on grades
· Minor improvements to the Stock Dialog
· Editing properties of flex tracks at a height above zero level could reset the flex shape to a straight track shape

Changes in 4.0.1
(19. January 2011)

. RAILMODELLER

· Improved terrain generation creating smoother landscapes
· Layer visibiliby was ignored when printing always printing hidden layers
· Fixed a refresh issue in the partlist
· Improved placement of toolbar and palette windows for configurations with the Dock on the left/right border of

the screen
· RailModeller no longer claims to be an editor for CSV files in the Finder
· Display info message when a track helix can’t be created from railsets without curved tracks
· Improved messages when grades could not be created for various reasons
. RAILSET EDITOR

· Opening railsets could result in an error message
· Fixed an issue with overlapping views in the main window
· Minor improvements to the user interface

Changes in 4.0
(10. January 2010)

. RAILMODELLER

· Support for full three-dimensional planning with heights and grades added
· New “Grade/Height Dialog” to create graded track sections or move elements to a specific height
· New “Track Helix Dialog” to conveniently create track helixes
· Optional Grade Profile view in the worksheet window showing a frontal view of all tracks and their respective

heights
· Support for layers added with the ability to assign elements to a layer and to hide/show and lock layers
· New Layer Palette
· New Layer menu for creating, renaming, deleting, locking, hiding and assigning elements to layers
· Info Palette now displays the height and grade of the selected track element in per mille
· New Display menu option to show track heights (optionally only in graded sections)
· New option to offset the height display for track elements for better readibility
· New printing architecture fixes occasional 1:1 printout errors
· New function to select all track elements
· New function to select all elements in the active layer
· The measure tool optionally displays height differences between tracks with SHIFT
· Tooltips and the measure tool display were not shown on secondary monitors
· Update check without the worksheet window open could block the application
· “Connect with Flextrack” dialog preselects a track of the current railset
· “Connect with Flextrack” automatically created graded flextracks when connecting tracks at different heights
· Enhanced 3D mode shows tracks with real trackbed width and rail dimensions
· New option for 3D mode to show only track elements
· New automatic terrain generation feature for 3D mode
· New option to show elements of all (including hidden) layers in 3D mode
· New “Highlight unconnected Joints” track style option to highlight where tracks are not connected
· Fit to page zoom factor was wrong when print dialog was invoked for the first time
· “Cleanup Orphaned Tracks” now highlights tracks to be deleted and asks for confirmation
· Moving objects in the worksheet now retains the order of the element/group
· “Invert Selection” sometimes failed to invert the selection state of grouped elements
· New export functionality to save layouts as simple layout interchange format (SLIF) version 2 to be imported by

third party applications
· Dragging items out of the worksheet or to invalid locations caused them to disappear
· Numerous internal changes to improve the application performance
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Changes in 3.1.6
(04. September 2009)

. RAILMODELLER

· Flextracks can snap to other tracks when editing the flextrack shape using the mouse
· New “Track Names Only” function (Display menu) to display element names only for track elements
· All occurances of an element can be selected in the worksheet from within the Partlist dialog
· Triple click on an element selects all connected elements
· Holding the Option key while creating a circle or rectangle centers the new element at the initial mouse position
· Minor improvements in the “Connect with Tracks” dialog
· Fixed missing localizations for flextrack warning messages
· Creating a new selection marquee while holding the Shift key now keeps the current selection
· Generic flextrack names and descriptions are now properly kept up to date
· The “Connect With Flextrack” function now creates generic flextracks with a max. length of 110% of the length

required for the connection
· Product number and description for generic flextrack changed to be more consistent
· Situations where stock elements are not found in any known railset are handled more gracefully
· Fixed a cosmetic bug when shaping flextracks with no fill color

Changes in 3.1.5
(26. July 2009)

. RAILMODELLER

· An error was reported when elements using quotes (”) in the product number were used in the stock
· Fixed a memory leak causing crashes especially with the polygon and line tools
· Cloning multiple elements (option click and drag) reversed the element order
· Default railsets with umlauts could not be loaded automatically at startup
· Display of long filenames fixed in various places
· Curved elements could be displayed with holes on top in 3D
. RAILSET EDITOR

· Importing SVG elements containing relative paths didn’t work
· Fixed import of SVG elements with paths using coordinates in exponent notation
· Various minor improvements in SVG import
· Fixed refresh issue in element editor view

Changes in 3.1.4
(9. March 2009)

. RAILMODELLER

· New “Export to TrainPlayer” feature for transferring RailModeller layouts into TrainPlayer
· Railset Editor couldn’t be launched from RailModeller on Mac OS 10.5
· Fixed cosmetic glitch for dragged elements on Mac OS 10.5
· Improved hightlighting of selected element in RailSet Palette
· Update check didn’t show result until connection time-out
· Fixed a problem with wrong zoom settings for the Fit to Page printing option

Changes in 3.1.3
(17. September 2008)

. RAILMODELLER

· Fixed wrong display of elements

Changes in 3.1.2
(16. September 2008)

. RAILMODELLER

· Improved performance of numerous operations
· New function to export the parts remaining in the stock for the current worksheet
· New function to select all text elements of a worksheet
· Paste was not functional in the contextual menu
· Some Mac OS X dialogs were not localized for the german locale
· Saving files on a path containing non-Latin characters failed with an error message
· Fixed a cosmetic problem when dragging text elements
· Fixed a wrong error message when launching the Railset Editor from RailModeller
· Fixed display of text elements in 3D mode on Intel Macs
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Changes in 3.1.1
(20. May 2008)

. RAILMODELLER

· Startup delay in the demo version splashscreen removed
· Fixed a problem with potentially wrong element colors on Intel Macs
· Fixed a problem with bad palette window positions on Intel Macs
· Files in the recent file list could sometimes not be opened
· Cosmetical glitch in the Software Update dialog fixed
· The last 3D position was not handled correctly on Intel Macs

Changes in 3.1
(16. May 2008)

. RAILMODELLER

· Delivered as a Universal Binary running natively on both, Intel and PowerPC Macs
· Significantly improved loading time for large worksheets
· Toolbar segments can be configured directly via the Toolbar’s contextual menu
· New “Select in Railset Palette” function switches to the selected worksheet element in the Railset Palette
· Improved tape measure tool with new option to show horizontal and vertical distance as two distinct measurements
· The tooltip containing the current measurement was sometimes not displayed in the tape measure tool
· New option to print either 1 or 2 markers to help the assembly of multi-page printouts
· New options to print layouts in 1:2 and 1:10 scale
· Added automatic scrolling when elements are dragged near the edge of the worksheet window
· Smoother editing of polygon and flextrack points at high zoom levels
· New shortcut for “Connect segment to”
· New shortcut for “Select Connected Elements” (<Option>-Doubleclick)
· Minor improvements in the Stock dialog
· New “Paste Original Position” command to place a pasted element at the same position as the copied element
· Changing price and currency of flextracks didn’t work in the Partlist Dialog
· Fixed a very rare crash during printing
· Fixed a cosmetical glitch when dragging elements under Mac OS 10.5
· Mac OS 9 no longer supported, OS 10.3 or better required
. RAILSET EDITOR

· Delivered as a Universal Binary running natively on both, Intel and PowerPC Macs
· Mac OS 9 no longer supported, OS 10.3 or better required

Changes in 3.0.5
(11. December 2007)

. RAILMODELLER

· Move element to front/back now possible for multiple elements
· Pages were missing in printouts
· The grid could be printed in the wrong scale
· Outline mode for polygon elements didn’t work

Changes in 3.0.4
(28. October 2007)

. RAILMODELLER

· Added import of Mac MoVe XML files written by Mac MoVe for english locale
· Improved ruler display for feet units
· New “Center On Current Selection” function
· Improved zooming behaviour to always keep the center of the worksheet centered
· Minor improvements in the “Worksheet Properties” dialog
· Mouse cursor was sometimes wrong in various tools
· The “Connect With ..” modes could hang when the Move Worksheet shortcut (<Cmd> - Mouse) was used

during joint selection
· Long descriptions and comments were cut off after 255 characters in the Worksheet Information dialog

Changes in 3.0.3
(21. August 2007)

. RAILMODELLER

· Improved Polygon Editor allows to convert polygon to line elements and vice versa
· New “Scale Element” function in the Polygon Editor
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· Flextracks, polygon and line elements could no be selected via mouse clicks
· Constraints check was disabled when editing flextracks
· Small text font size corrected for Mac OS 9

Changes in 3.0.2
(7. August 2007)

. RAILMODELLER

· The suffix for exported graphics files is automatically appended to the filename
· Short click in the toolbar rotate control didn’t bring up the “Rotate Elements” dialog
· Tracks in the Railset Palette now use the drawing style chosen in the current worksheet
· A slightly wrong center position could be displayed by the “Move Elements” dialog depending on the current

worksheet zoom factor
· On multi-processor machines the “Connect with Tracks” function could crash
· Fixed a crash at application startup with certain preferences settings
· Fixed a crash when working with text elements under Mac OS 9
· Improved error message when files with wrong file types are dropped on the application icon

Changes in 3.0.1
(15. June 2007)

. RAILMODELLER

· Various cosmetic fixes on Mac OS 9
· Entering license keys from the “Registration” panel of the preferences didn’t work on Mac OS 9
· Misleading error message fixed when default railset could not be located
· Import of Mac MoVe XML documents could result in an endless loop
· Elements in the Railset Palette were sometimes drawn in text representation even if they could have fitted into the

buttons
· The “Bend to Curved” panel of the Flextrack editor could display a wrong error requester in a loop
· The Railset Editor could not be started using the “Element > Launch Railset Editor” menu item
· White colored elements could not be selected by clicking them
· An error message could pop up after editing flextracks and polygons with contextual menu commands
. RAILSET EDITOR

· New “Set Middle Rail Setting to All Elements” function
· Wrong tracklength for curved tracks could be displayed
· Outline inactive only had an effect for track components
· Specifying the rail head width had no effect
· Elements in the ”Library Contents” list were sometimes drawn in text representation even if they could have fitted

into the list
· Help > RailModeller Manual displayed an error message

Changes in 3.0
(3. June 2007)

. RAILMODELLER

· Customizable track drawing styles: full trackbed width, gauge width, single line. Optionally draw trackmarks,
joints and center line

· Stock management added
· Stock can be imported from and exported to either Mac MoVe or plain CVS text files (Tab separated)
· The number of elements remaining in the stock can optionally be displayed in the Railset Palette
· The display of flags for obsolete elements in the Railset Palette can now be controlled from the preferences
· All file exports have been replaced by a single export dialog with file format popup
· New “Connect with Sectional Track” function automatically connects two tracks with a variable number of

sectional tracks
· The Options menu has been removed: application wide settings have been moved to the preferences dialog,

worksheet related settings to the new Display menu
· New Arrange menu provides direct access to functions for connecting tracks and segments
· New Preferences dialog
· New Toolbar with configurable contents and icon sizes
· Enhanced Print dialog
· Layouts can be printed in full size (1:1 scale)
· New option to omit pages without tracks from the printout
· New option to print markers to ease the assembly of printouts with multiple pages
· Automatically adjust the printout size to the margins of the currenty selected printer
· Name of printouts as displayed in the Printer Dialog or the Mac OS Preview application was sometimes wrong
· Extended worksheet properties dialog
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· Additional fields for worksheets to enter comments and a file revision
· Worksheet descriptions can contain up to 4096 characters
· Text elements can be edited directly in the worksheet
· Text elements can have up to 4096 characters
· Improved drawing speed for text elements
· New “Cleanup Orphaned Tracks” function
· Currency and measurement units were not displayed localized in all dialogs
· New Partlist dialog with integrated price editor
· Partlists can be copied to the clipboard
· New concrete, grass and sand textures for 3D mode
· “Flextrack Properties” dialog allows editing the trackbedwidth for a particular or all dynamic flextracks of a

worksheet
· Direct access to rotation by 15, 30, 45, 90 and 180 degrees via Rotate control popup window
· New Railset Palette function to launch the Railset Editor with the railset currently displayed in the Railset Palette
· About box and Registration panel in the preferences now provide assistance for installing the license key
· Selected elements are framed in red color to be easier recognizable from unselected elements
· Default element name color was not stored in the preferences
· Fixed a bug in “Connect with Flextrack” where valid destination joints were sometimes not selectable as target

joint
· License keys are no longer release specific and have been moved to “ /Library/Application Support/RailModeller/Software

License”
· Sometimes the length of a group of tracks wasn’t calculated correctly
· Mac OS 8.6 support dropped, minimum OS version supported is OS 9
. RAILSET EDITOR

· New Comment field for railets to denote additional information related to the railset
· New field for trackbed width
· New field for rail width
· Improved Railset Comparison dialog
· Mac OS 8.6 support dropped, minimum OS version supported is OS 9

Changes in 2.3.4
(2. July 2006)

. RAILMODELLER

· Redesigned and improved print dialog
· Center label for printouts can optionally contain date or user specified text
· New “Fit Worksheet” option to automatically adjust zoom factor to fit on a single page
· New selection mode to select all elements of the same railset
· Worksheet rulers displayed wrong information when units were set to feet
· The page number was missing in print outs
· Elements were sometimes missing in printouts
· Row and column coordinates of pages were not printed
· Problem with the application icon corrected, could be displayed incorrectly on some Mac OS X systems
. RAILSET EDITOR

· Problem with the application icon corrected, could be displayed incorrectly on some Mac OS X systems

Changes in 2.3.3
(9. May 2006)

. RAILMODELLER

· The Tape Measure could crash the application on certain systems
· Measurements for the Tape Measure were sometimes displayed at wrong locations
· Tooltips were sometimes not shown
. RAILSET EDITOR

· Maximum trackwidth increased to 650mm
· Creation of rounded rectangles in the Polygon/Rectangle Dialog
· SVG importer crashed for some graphic files
· Improved SVG importer, now supports bezier curves and rounded rectangles
· Elements pasted into railsets did not adapt their modelscale to the hosting railsets scale

Changes in 2.3.2
(16. March 2006)

. RAILMODELLER

· When selecting elements with the lasso the current width and height of the selection rectangle is displayed in the
position display
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· Improved Element Info dialog for all element types, now shows dynamic descriptions for elements created on the
fly

· Fast unit switch via CTRL + Option + PageUp/PageDown allows to change the current unit without invoking the
preferences

· Fixed a drawing bug in the Element Info dialog for huge elements
· “Bend To Straight” and “Bend To Curved” dialogs now provide an easy way of using the full flextrack length

for parametrically bent tracks
· Application icon was still displayed as a document icon on some Mac OS 10.4 systems
· When exporting partlists from the Partlist dialog the dialog lost focus after replacing an existing partlist file
· Opening the 3D mode could hang in an endless loop for worksheets with particular curved elements
· The 3D menu was not responsive when switching to another application and back to the 3D view
· Rectangle elements would sometimes disappear or be partly invisible after changing the dimensions
· Correct a wrong tooltip for the info window, added tooltips for the worksheet position display and zoom button
. RAILSET EDITOR

· Fixed a crash when loading railsets with 1 or no elements

Changes in 2.3.1
(12. December 2005)

. RAILMODELLER

· The application icon was displayed as a document type icon on particular Mac OS 10.4 systems
· The worksheet rulers displayed divisions of 10 units with 12 subdivisions for imperial units

Changes in 2.3
(21. November 2005)

. RAILMODELLER

· Layouts can be up to 1000m × 1000m (3280ft × 3280ft)
· Zoomlevels of up to 500% for editing, exporting and printing
· New Color Palette
· The Railset Palette can optionally be displayed horizontally beneath the worksheet window
· New category filter in the Railset Palette
· Railsets can be dynamically sorted in the Railset Palette by several modes
· Improved appearance and readability of the Railset Palette buttons
· New categories: Slot Car, Digital/Electric, Symbols
· New Colorize Selection menu item
· Elements can be drawn outlined, without fill color
· Optionally display product number and description in the Info-Window
· New 10% setting for element name text size
· Added support for Danish Krone (DKK)
· New “Dark Grey / White” worksheet color scheme
· The grid can be displayed in 3D view
· 3D view can be controlled via numeric keypad and cursor keys
· Improved automated layout of palette windows via Cleanup Windows for more effective use of screen real estate
· Internal printing architecture completely rewritten to allow much larger printouts and to consume less memory

and CPU
· Optionally display the coordinate for each page of a printout for easier assembly of the pages
· Pressing <Shift> while dragging elements inside the worksheet limits the movement to the horizontal or vertical

axis
· Default worksheet dimensions in the preferences would sometimes round user input to incorrect values when

using inch or feet
· Improved display of text elements in the 3D view (especially for large worksheets)
· “Cleanup Windows” better recognizes switched screen resolutions
· Automated search for a registered older release on the local harddrive to automatically unlock the new release

using an existing license key
. RAILSET EDITOR

· Elements can be imported from SVG files
· Direct entry of polygon-point made more convenient for more than 10 points
· New “Scale Element” dialog for elements without track components
· New options to ask for confirmation when deleting elements and/or components
· Added support for Danish Krone (DKK)
· New option to sorting railsets automatically by type
· Optionally display the polygon point index of the currently edited polygon component as a tooltip
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Changes in 2.2.5
(2. July 2005)

. RAILMODELLER

· The Element Info dialog can now be invoked for elements in the Railset Palette by clicking on elements in the
palette while holding <CMD>

· Fixed a problem with text selection under Mac OS 10.4
· Print Dialog didn’t work correctly under Mac OS 10.4
· Fixed a floor texture problem in 3D mode (Mac OS 10.4)

Changes in 2.2.4
(23. February 2005)

. RAILMODELLER

· Fixed a problem when saving previews with newly created worksheets
· Fixed a bug where white text was not visible in 3D mode
· Double-Clicks in Tape Measure mode could sometimes leave the ruler on the worksheet
· New “Zoom to Width”, “Zoom to Height” options in worksheet zoom popup
· All textures can now be turned off via menu in 3D mode

Changes in 2.2.3
(7. February 2005)

. RAILMODELLER

· Page Setup settings are saved with worksheets
· Full screen option for 3D mode
· Texture for border-box can be turned off for Macs with slow graphics hardware
· Improved “Flextrack Properties”, “Bend To Straight”, “Bend To Curved” dialogs
· Fixed a problem with the Chicago font on some 10.x systems, Default font is now Geneva

Changes in 2.2.2
(16. January 2005)

. RAILMODELLER

· Markers for “Connect with Flextrack” were not displayed
· Wrong initial library was loaded to the Railset Palette if no default library was chosen
· Manual wasn’t found in the new “Documents” folder when opened from RAILMODELLERor RAILSET EDITOR

· Fixed display of flextracks in 3D mode
· Fixed wrong color settings of text-objects in printouts and file previews
· Manual enhanced and updated

Changes in 2.2.1
(9. January 2005)

. RAILMODELLER

· Worksheets Documents can be opened by dragging the files to the worksheet window
· Default font for text elements can now be customized
· Display of worksheet location in worksheet info
· Improved display of rulers and fixed a bug when displaying Feet units
· Fixed a drawing bug were text on 8.6/9.x could overwrite the window scrollbars
· Fixed possible crash on 8.6/9.x with the worksheet-window zoom-popup menu
· Fixed a bug with elements sometimes displayed in wrong colors in 3D view
· Fixed a bug with misplaced text in 3D view
· Undo after 3D view could cause a crash
· Minor user-interface enhancements
. RAILSET EDITOR

· New buttons for more convenient editing of component angle and position
· Minor user-interface enhancements

Changes in 2.2
(25. October 2004)

. RAILMODELLER

· New functions for creating groups of elements
· Text elements can be rotated to arbitrary angles
· Flextracks can be bend parametrically to any straight or curved track
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· “Connect with Flextrack” can now use flextracks from libraries
· New alternative pattern for selected elements
· New option for drawing Element-Name with outlines
· Support Pound Sterling (£), Swiss Franc (CHF), Swedish Krona (SEK), Yen (JPY)
· New <CMD><ARROW> shortcut for scrolling the worksheet
· Support midrail for authentic 3-rail tracks
· Default width and height for worksheets can be set in the preferences
· Online-Help in preferences added (Tooltip for every option)
· New 3D Textures: Lawn, Sand 1, Sand 2
· Text is now displayed as a texture with chosen font in 3D view
· Optimized display of textures in 3D view and cosmetic enhancements
· Native support for scrollwheels (Mac OS X only)
· Added Undo/Redo for Prefix, Elementname Display, Grid
· Improved hierarchical directory structure for Railsets folder
· Enabled copy & paste between Railset Editor and RailModeller
· Dragging single elements with <Shift> crashed the application
· Recent Menu items starting with a hyphen were not displayed
· Creating 90-degree flextracks sometimes didn’t work in “Connect with Flextrack”
· Fixed a cosmetic flaw in “Connect with Flextrack” with very distant joints
· Fixed an error where dragged elements would sometimes not snap
· Element-order was reversed for canceled Drag & Drop operations
· Particular elements (e.g. turntables) sometimes failed to connect
· Fixed a bug in the “Move Selection” Dialog
· Correction of several translations
· Fixed mixed linebreak style in exported partlists
· Fixed a few memory leaks
· Fixed various issues with Mac OS 8.6
· Fixed several minor bugs
. RAILSET EDITOR

· New “Polygon-Tool” function: Scale, Merge, Mirror X/Y, Round
· Improved polygon and line macros
· Introduced Cut/Copy/Paste for elements and components
· Support middle rail for authentic 3-rail tracks
· Support for 00-Gauge (1:76)
· Support for Pound Sterling, Swiss Franc, Swedish Krona, Yen
· Improved railset comparison function
· New Minimal List View Zoom preferences option
· Native support for scrollwheels (Mac OS X only)
· Rulers always started at 100% despite default zoom setting
· Recent Menu items starting with a hyphen were not displayed
· Fixed sorting in comparison dialog
· Fixed error when calling the Curved Turnout macro twice
· Fixed various issues with Mac OS 8.6

Changes in 2.1
(20. May 2004)

. RAILMODELLER

· Localized RailModeller application with german and english locale
· New function “Connect Segment To” joins two segments
· New “Open Recent” menu
· New Gridsizes 1,6,12 and 24 suitable for imperial units and 250
· Drag & Drop is now possible for any number of elements
· Clipboard-Operations can be applied to groups of elements
· Move/Rotation can be applied to groups of elements
· Worksheets are now saved with a (Finder-) Preview
· Magnetic area of the joints can now be adjusted in the preferences
· <Shift> + <Option> can now be used to temp. activate the Append-Mode for Flextracks
· New option to hide the footer in printouts
· New Selection Modes: “Select Similar Modelscale”, “Select Similar Manufacturer”
· Improvements in the “Connect with Flextrack” function
· Improved error-handling in the Price Editor
· Detailed Element Statistics in “Worksheet Info”
· Several improvements in the 3D-View
· Fixed a bug where the Image Export displayed wrong size information
· Choosing new color with <Option> + Click on the Color-Button didn’t work well under 10.3
· Prefix-Display in the Railset Palette wasn’t updated after loading new worksheet
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· Undo after changing the Worksheet size could cause strange effects or a crash
· Ground texture in 3D view was sometimes reset to default
. RAILSET EDITOR

· Localized Railset Editor application with german and english locale
· Redesigned most dialogs to be more intuitive
· Introduced preferences for the Railset Editor
· New “Open Recent” menu
· New option to automatically load the railset last worked on at startup
· Added support for S-Gauge (1:64)
· New, extensive “Compare Railsets” function
· Various minor improvements

Changes in 2.0.1
(27. October 2003)

. RAILMODELLER

· New “Elements Railset to Palette” function selects the current railset from any worksheet-element
· New Shortcut to switch to previous or next element of a railset
· New Shortcut to Shows/Hide all palette windows
· Added back support for Mac OS 8.6
· New Option to Auto-Open the worksheet last used when application launches
· Position and visibility of palette-windows now stored in the preferences
· Improved drawing of flextracks for very small zoom-settings
· Corrected Element-Name default setting, names always hidden
· Rotation sometimes issued incorrect or no warnings near worksheet borders
· Fixed a problem with the “Move Element” dialog
· Various minor improvements
. RAILSET EDITOR

· New polygon attribute to display line-segments
· New “Search/Replace for Attribute Strings” function
· New functions to determine order of elements in the railset
· Minor GUI enhancements
· Next/Previous Point shortcuts didn’t always work
· Memory for closed railsets wasn’t deallocated under certain circumstances

Changes in 2.0
(22. August 2003)

. RAILMODELLER

· Native support for Mac OS 9.0 - 10.x
· Support for Flextracks
· Added Support for various Units: Millimetre, Centimetre, Inch, Feet
· Automatic calculation of the overall tracklength of tracks, selections and worksheets
· New flexible Zoom-System with 5-100% and Zoom-To-Fit Feature
· New Info-Window
· New Price-Editor for Worksheets: Instant editing of Element-Prices, Sync. Prices from Worksheets and Railsets
· Enhanced Selection Modes: Select Similar Elements, Select Elements of the same color, Inverse Selection
· New “Duplicate Element” Command
· New function for connecting elements with a flextrack
· Optional display of Prefixes for Elements, e.g. ’Fl-6100’ for Fleischmann tracks
· Option-Key can be used to copy any dragged element
· Improvements for the Polygon, Rectangle and Circle Tools
· Linewidth of Lines, Rectangles, Polygons and Circles can now be adjusted
· Fast access to the preset colors via F-Keys
· Many minor improvements
· Fixed a problem occuring on some systems when starting the 3D mode
· The correct currency is now always displayed
. RAILSET EDITOR

· Native support for Mac OS 9 - 10.x
· Support for Flextrack Components
· New Turntable Macro
· New Transfer Table Macro
· Support for Linewidth of Polygon and Circle Components
· Display of Item/Component-Lists now scaled dynamically
· Improved Zooming for Item-View (25 - 400%)
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Changes in 1.1.3
(23. March 2003)

. RAILMODELLER

· Fix of a bug that would crash the application with an empty Railsets folder
· Fix of misplaced tooltips when creating ovals
· Fix of bad element-name placement under certain circumstances for snapped and joint-rotated items

Changes in 1.1
(5. February 2003)

. RAILMODELLER

· New “Measuring Tool”
· New “Colorize Tool”
· New “Eyedropper Tool”
· New “Joint Rotate” function
· Improved Partlist: Sortable by any criteria (name, price, etc.)
· Grid-Spacing for Worksheets can be adjusted from 5-100cm
· Added point-editing for polygons and linesegments
· RAILMODELLER no longer requires the editor to be named “Railset Editor”
· Added support for obsolete elements in the Railset Palette
· Improved rendering of track elements
· Improved decimal-fields for the Move/Rotate Element dialogs
· Improved Text-Elements: Blocks of very small text are now displayed as patterned rectangles to be better distin-

guishable from plain rectangles.
· Added 3D-Mode support for Text-Elements
· Minor improvements in the Rectangle-, Circle-, Line- and Polygon-Modes
· Fixed a refresh problem in the Move Element dialog
· Fixed various price-related problems
. RAILSET EDITOR

· New Element-Flag “Obsolete” describes the availability of elements
· New Library-Properties “Manufacturer-URL” (Main & Optional)
· New macro for “Curved Turnouts”
· New, customizable “Joint-Alignment Dialog”
· New “Import Function” for merging railsets
· New “Mirror Function” for components
· New “Synchronize Price” and “Synchronize Description” functions for synchronizing price and/or description

changes between two versions of the same railset
· Added support for Circle Components
· Parameters can be entered more precisely (1/1000 mm)
· Various minor user-interface improvements

Release 1.0
(15. December 2002)

Initial Release of RAILMODELLER.
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All rights reserved. No part of this manual may be reproduced without the prior
written permission of the author.

This manual was typeset with the LATEX document preparation system using
TeXShop, http://www.uoregon.edu/˜koch/texshop.

Designations used by companies to distinguish their products are often
claimed as trademarks or registered trademarks. In all instances where the author
of this manual is aware of a claim, the product names appear in capital letters. For
more complete information regarding trademarks and registration please contact
the appropriate companies.

Copyright c© 2002-2015 by MacRailSoft
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